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Modul 1  : Dasar Fotografi: Pengenalan Kamera  

Materi Estimasi Waktu Capaian Pembelajaran 

a. Pengenalan fungsi panel 

dan bagian-bagian 

kamera DSLR 

 

Materi : 60 Menit 

Praktikum : 110 Menit 

a. Mahasiswa mampu 

memahami dan 

mengaplikasikan dasar 

fotografi berupa 

mengenal bagian – bagian 

kamera 

 

Materi 1  

I. Pengenalan Kamera DSLR Bagian Belakang  

 

 

Gambar 1.  1. Bagian Belakang Kamera DSLR 

Sumber: (Syahriszani, 2022) 

NO NAMA BAGIAN KAMERA FUNGSI 

1 Monitor LCD Sebagai layar yang meanmpilkan informasi – informasi 

rinci untuk setting kamera dan menampilkan hasil 

gambar yang telah diambil 

2 Eyecup Bagian untuk mencegah cahaya eksternal masuk ketika 

menggunakan vIewfinder untuk membidik objek. 

3 Viewfinder Eyepiece Jendela kecil pada kemaera yang berfungsi untuk 

melihat objek serta fokusnya ketika membidik gambar 



NO NAMA BAGIAN KAMERA FUNGSI 

4 Kenop Penyesuaian 

Dioptrik 

Berfungsi untuk mengatur kejernihan gambar yang 

terlihat dari viewfinder. Cara penggunaannya dengan 

memutar kenop saat melihat objek melalui viewfinder 

5 Saklar Live View Shooting 

/ Movie 

Mempunyai 2 fungsi yaitu: 

a. Ketika Memotret 

Digunakan untuk menghifupkan atau mematikan 

fungsi live view. Dengan menekan tombol ini satu 

kali makan akan tampil gambar live view pada 

monitor LCD dan dapat memotret dengan melihat 

di monitor LCD 

 

b. Merekam Video  

Pada saat merekan video tetapkan dulu mode 

pemotretan ke “Movie Shooting” yang terdapat 

pada mode dial. Kemudian tekan tombol ini untuk 

mulai merekan video dan tekan lagi jika sudah 

selesai. 

6 Tombol Pemilihan Titik 

Fokus 

Berfungsi untuk masuk ke mode autofocus (AF point) 

selama pemotretan. Titik AF dapat diatur secara manual 

menggunakan tombol Multi – Controller 

7 Tombol Erase Berfungsi untuk menghapus gambar yang tidak 

diinginkan 

8 Tombol Quick Control digunakan untuk menampilkan setting-an quick control  

yang memungkinkan untuk mengatur dan 

mengonfirmasi berbagai pengaturan pada kemera. 

9 Tombol Tamplina (DISP) Berfungsi untuk: 

a. Menghidupkan atau mematikan tampilan  

b. Tampilan yang berganti – ganti antara tanpilan 

informasi mode image atau movie playback  selama 

pengambilan gambar live view 

c. Menampilkan pengaturan fungsi pada kamera 

ketika menu ditampilkan 



NO NAMA BAGIAN KAMERA FUNGSI 

10 Tombol ISO Speed Berfungsi untuk mengatur atau menyesuaikan 

sensitivitas kamera terhadap cahaya 

11 Tombol SET/Multi-

Controller 

Berfungsi untuk: 

a. Menggerakkan diatara beberapa item menu 

b. Mengganti tampilan gambar pada monitor LCD ke 

gambar selanjutnya atau sebelumnya  

c. Menggeser tampilan gambar pada monitor LCD 

yang sedang diperbesar ke titik yang lain 

d. Menggerakkan titik AF selama pemilihan titk AF  

Dalam mode pemotretan, tombol ini fungsinya beralih 

ke tombol yang ditunjukkan oleh ikon yang ada 

padanya. Sedangkan tombol SET mengonfirmasi 

pemilihan  

12 Tombol Playback Tombol yang digunakan untuk memutar video yang 

telah kita ambil 

13 Tombol Menu memiliki menu – menu yang digunakan untuk mengatur 

kamera lebih rinci 

 

 

II. Pengenalan Kamera DSLR Bagian Depan  

 

Gambar 1.  2. Bagian Belakang Kamera DSLR 

Sumber: (Syahriszani, 2022) 

 



NO NAMA BAGIAN KAMERA FUNGSI 

1 Tombol Rana Berfungsi untuk membidik gambar, Terdapat dua tahap 

dalam menekan tombol rana yakni: 

a. Ketika menekan separuh to,bol makan berfungsi 

untuk mengaktifkan fungsi AF 

b. Ketika menekan seluruh tombol berfungsi untuk 

melepaskan rana atau memotret 

2 Lampu Pengurangan 

Mata Merah / Self Timer 

Penggunaan fitur ini karena dua hal yaitu: 

a. Ketika red-ey reduction (pengurangan mata 

merah)pada kamera diaktifkan kemudian tekan 

separuh tombol rana maka lampu tersebut akan 

menyala jika menggunakan lampu kilat built-in 

b. Ketika self-timer diaktifkan maka lampu ini akan 

menyala selama timer tersebut berjalan sampai 

gambar diambil. 

3 Dudukan Lensa Berfungsi untuk penghubung lensa yang dapat 

dipertukarkan ke kerangka kamera. Untuk memasang 

lensa denga cara menderetkan indeks dudukan lensa 

pada lengsa yang akan dipasang pada dudukan lensa, 

kemudian putar lengsa seara jarum jam hingga 

terdengar bunyi klik. 

4 Indeks Dudukan Lensa Pada saat memasang atau melepas lensa baik ketika 

membersihkan lensa atau mengganti lensa, tanda 

tersebut harus disejajarkan dengan tanda yang ada di 

lensa. Adapun arti kedua tanda tersebut adalah: 

a. Indeks merah digunakan unutk lengsa EF. Dapat 

diaplikasikan pada DSLR full-frame maupun APS-C 

dari Canon 

b. Indeks putih digunakan untuk lensa EF-S. Dapat 

diaplikasikan pada DSLR APS-C Canon 

5 Tombol Pelepas Lensa Tekan tombol jika ingin melepas lensa. Ketika tombol 

ditekan pin kunci lensa akan ditarik keluar sehingga 

dapat memutar lensa secara bebas. Kuncikan lensa ke 



NO NAMA BAGIAN KAMERA FUNGSI 

dalam tempatnya dengan memutarnya hingga 

terdengar bunyi klik sebelum proses membidik objek. 

6 Cermin (Mirror) Berfungsi untuk memantulkan cahaya dari lengsa ke 

viewfinder sehingga dapat melihat objek yang akan 

dibidik melalui viewfinder dalam waktu nyata. Mirror 

segera berputar balik tepat sebelum melapaskan rana 

7 Mikrofon Mikrofon built-ini berfungsi untuk menangkap bunyi 

audio selama proses perekaman video. 

8 Lampu Kilat Built-in / 

Flash 

Berfungsi untuk membantu menambahkan cahaya  

 

III. Pengenalan Kameran DSLR Bagian Atas 

 

Gambar 1.  3. Bagian Atas Kamera DSLR 
Sumber: (Syahriszani, 2022) 

 

NO NAMA BAGIAN KAMERA FUNGSI 

1 Focus Ring Apabila kamera berada pada manual focus mode, focus 

ring berfungsi untuk mengatur dan menyesuaikan fokus. 

Posisi Focus ring tidak selalu sama, tergantung lensa 

yang digunakan. 

2 Zoom Ring Berfungsi untuk mengubah focal length (panjang fokus) 

dengan memutar zoom ring 



NO NAMA BAGIAN KAMERA FUNGSI 

3 Saklar Focus Mode Berfungsi untuk memilih antara Automatic Focus (AF) 

atau Manual Focus 

4 Speaker Ketika sudah selesai merekam video dan memutar 

hasilnya, maka sura yang terekam di dalam video akan 

keluar melalui speaker ini. Untuk menyesuaikan 

besarnya volume bisa dengan memutar Main Dial.  

5 Gantungan Tali  Tempat untuk menggantungkan tali pada kamera. Tarik 

ujung tali melalui lubang kemudian kencangkan, 

pastikan kedua ujung tali sudah seimbang. 

6 Hot Shoe Hot Shoe merupakan terminal yang digunakan untuk 

memasang flash external.  Melalui kontak, data 

ditransmisikan anatar kamera dan flash. 

7 Saklar Daya Berfungsi untuk menghidupkan dan mematikan kamera.  

8 Tombol Flash (Lampu 

Kilat) 

berfungsi untuk memunculkan built-in , Flash built-in 

dapat muncul dengan sendirinya atau otomatis 

berdasarkan fungsi yang sedang digunakan dan berada 

pada basic zone. 

9 Mode Dial  Mode dial dapat diputar untuk memilih shooting mode 

sesuai dengan pemandangan yangingin ditangkap. 

Secara umum, shooting mode terbagi menjadi dua 

bagian berbeda, yaitu: 

a. Creative Zone 

Pada creative zone dapat memilih dan menetapkan 

fungsi menurut tujuan yang diinginkan 

b. Basic zone 

Pada basic zone tidak bisa memilih dan 

menetapkan fungsi, kamera akan secara otomatis 

memilih pengaturan sesuai dengan pemandangan 

yang terekam oleh lensa 

10 Main Dial Bagian ini merupakan dial multiguna yang dapat 

dilakukan untuk beberapa tugas seperti setting pada 

Aperture / Shutter Speed / Exposure dan bisa juga 

digunakan untuk menggeser gambar. 

 



IV. Pengenalan Kamera DSLR Bagian Bawah 

 

Gambar 1.  4. Bagian Bawah Kamera DSLR 
Sumber: (Syahriszani, 2022) 

 

NO NAMA BAGIAN KAMERA FUNGSI 

1 Wadah Baterai dan Slot 

Kartu 

a. Wadah Baterai merupakan tempat baterap kamera 

berada di bagian bawah. 

b. Slot kartu digunakan untuk menaruh kartu memori 

yang berfungsi untuk menyimpan gambar 

2 Soket Tripod Soket tripod digunakan untuk memasangkan kamera 

pada tripod. Pada sebagain besar kamera DSLR, soket 

yang digunakan adalah ukuran uliran sekrup standar ¼-

20 UNC dan itu yang umum digunakan pada tripod. 

 

  



V. Pengenalan Kamera DSLR Bagian Samping 

 

Gambar 1.  5. Bagian Samping Kamera DSLR 
Sumber: (Syahriszani, 2022) 

 

NO NAMA BAGIAN KAMERA FUNGSI 

1 Terminal Remote Control  Berfungsi untuk menghubungkan kamera dengan 

perangkat eksternal 

2 Terminal Auido / Video 

Out/ Digital 

Digunakan untuk menyambungkan mic ke kamera saat 

digunakan untuk merekam video. Mic tersebut yang 

berfungsi untuk input suara. 

3 Terminal HDMI Mini Out Bagian ini merupakan terminal untuk TV Ouput dan 

transmisi data, serta HDMI mini output 

4 N-Mark Menyentuh N-Mark pada smatphone NFC-Compatible 

akan mengawali pairing antara kamera dengan 

smartphone 

 

  



LEMBAR KERJA 

Nama   : 

NIM  : 

Jenis Tugas : Praktek Individu  

Metode/Cara Pengerjaan Tugas: 

1. Menyebutkan nama bagian dan fungsi dari bagian kamera yang ditunjuk. 

2. Mempraktekkan cara memegang kamera dan menggunakannya secara sederhana. 

 

  



Modul 2  : Dasar Fotografi: Pengaturan Cahaya  

Materi Estimasi Waktu Capaian Pembelajaran 

a. Pengaturan pencahayaan 

(Triangle Exposure) 

Materi : 60 Menit 

Praktikum : 110 Menit 

a. Mahasiswa mampu 

memahami dan 

mengaplikasikan dasar 

fotografi mengenai 

pengaturan cahaya 

berupa Triangle Exposure 

 

Materi 2 

I. Pengertian Triangle Exposure 

Triangle Exposure atau Segitiga Exposure merupakan istilah yang merujuk pada 3 

elemen dasar yaitu Aperture, Shutter Speed dan ISO, tujuan dari segitiga exposure ini 

adalah untuk menyeimbangkan intensitas cahaya yang amsuk ke dalam kamera melalui 3 

metode atau elemen dasar yang berbeda. Berikut pengertian dari 3 elemen dasar segitiga 

exposure: 

1. Aperture adalah seberapa banyak cahaya yang masuk melalui lensa (sangat penting 

terhadap efek depth of field/bokeh) 

2. Shutter Speed adalag kecepatan waktu aperture terbuka dalam menerima cahaya yang 

masuk. 

3. ISO adalah tingkat sensitivitas sensor pada kamera  

 

Gambar 2. 1. Triangle Exposure 

Sumber : (Batubara, 2021) 

II. Penjelasan Masing – Masing Elemen Triangle Exposure / Segitiga Exposure  



1. Aperture  

 

Gambar 2. 2.  Aperture 

Sumber : (Batubara, 2021) 
 
 Aperture merupakan elemen pada Triangle Exposure / Segitiga Exposure yang 

mengatur seberapa banyak cahaya yang masuk melalui lensa pada bukaan diagfragma 

pada kamera, biasanya aperture disimbolkan dengan kode “F”, penggunaan Aperture 

biasanya untuk mendapatkan efek dept of field  atau bokeh pada suatu gambar.  

 Pada aperture jika skala “F” yang mempunyai skala F1,4 – F32, semakin kecil maka 

bukaan diagfragma pada lensa semakin besar yang berarti intensitas cahaya yang masuk 

akan semakin besar terhadap sensor sehingga menimbulkan efek dept of field  atau 

bokeh pada latar belakang objek yang diambil, hasil gambar yang dihasilkan seolah 

objek dengan latar belakang terlihat terpisah. Sedangkan jika pengaturan aperture pada 

skala “F” yang besar maka bukaan digafragma pada lensa semakin kecil, sehingga 

intesitas cahaya yang masuk akan semakin kecil terhadap sensor maka gambar yang 

dihasilkan akan terlihat jelas atau detail anatara objek dengan latar belakang.  

 Berikut contoh penggunaan aperture pada skala “F” kecil dan besar: 

 

Gambar 2. 3. Penggunaan Aperture Pada Berbagai Ukuran 

Sumber : (Batubara, 2021) 
 



2. Shutter Speed 

 

Gambar 2. 4. Shutter Speed 

Sumber : (Batubara, 2021) 
 

 Shutter Speed merupakan elemen pada Triangle Exposure / Segitiga Exposure yang 

mengatur durasi bukaan jendela sensor ketika menerima paparan cahaya sebelum 

menutup kembali. Shutter Speed diukur dengan satuan”S” atau second  dan dinyatakan 

dalam 1/500, 1/250, 1/125, 1/60, 1/30, 1/15, 1/8, 1/4 , 1/2.  

 Pada penggunaan Shutter Speed, semakin tinggi shutter speed yang digunakan maka 

semakin cepat jendela sensor membuka lalu menutup kembali, dan hasil gambar yang 

dihasilkan akan terlihat detail atau lebih tajam. Sedangkan jika menggunakan Shutter 

Speed yag rendah, maka bukaan jendela sensor lambat maka sensor juga akan 

membuka dan menutup dengan lambat, hasil dari gambar dengan shutter speed rendah 

adalah mendapatkan efek blur pada gambar. 

 Berikut contoh penggunaan aperture pada skala “F” kecil dan besar: 

           

 

   

 

 

 

 

 

 

 

 

 

 

 

 

3. ISO  

Shutter Speed Rendah Shutter Speed Tinggi 

Gambar 2. 5. Penggunaan Shutter Speed 
Sumber : (Batubara, 2021) 



 

Gambar 2. 6. ISO 

Sumber : (Batubara, 2021) 
 

ISO merupakan elemen pada Triangle Exposure / Segitiga Exposure yang mengatur 

tingkat sensitifitas sensor kamera terhadap cahaya. 

Pada penggunaan ISO jika nilai ISO semakin rendah makan hasil foto yang dihasilkan 

semakin gelap, sebaliknya jika nilai ISO semakin tinggi maka semakin terang foto yang 

dihasilkan. Namun apabila nilai ISO semakin tinggi maka akan menghasilkan gambar 

yang banyak noise (bitnik hitam) pada foto, sedangkan semakin rendah nilai ISO makan 

akan semakin jernih foto tersebut. Sehingga apabila mengambil gambar, diusahakan 

untuk mencari cahaya baik buatan ataupun alami (cahaya matahari) untuk tetap 

mengusakan nilai ISO yang digunakan.  

 

 

Gambar 2. 7. Penggunaan ISO 

Sumber : (Batubara, 2021) 
 

 

  



LEMBAR KERJA 

Nama   : 

NIM  : 

Jenis Tugas : Praktek Individu  

Metode/Cara Pengerjaan Tugas: 

1. Tugas berupa PDF dan dipresentasikan  

2. Mengambil gambar seperti contoh dibawah ini  dengan diberikan keterangan Aperture, 

Shutter speed dan ISO pada gambar, tema yang digunakan adalah “……………….”. 

Contoh Tugas: 

 

 

  



Modul 3  : Dasar Fotografi: Basic Composition 

Materi Estimasi Waktu Capaian Pembelajaran 

a. Basic Composition 
Materi : 60 Menit 

Praktikum : 110 Menit 

a. Mahasiswa mampu 

memahami dan 

mengaplikasikan dasar 

fotografi mengenai basic 

composition 

 

Materi 3 

 Komposisi dapat diartikan susunan, dalam istilah fotografi komposisi memiliki arti 

susunan gamabr dalam batasan satu ruang atau cara dalam menyusun elemen pada objek 

foto yang penting secara keseluruhan pada sebuah gambar yang diambil. 

 Ada beberapa komposisi dasar dalam pengambilan gambar, diantaranya adalah: 

I. Rule Of Third  

Rule Of Third merupakan jenis komposisi paling dasar. Metode yang digunakan pada 

komposisis ini adalah membagi 9 kotak besarnya sama dan menaruh point of interest (POI) 

di garis atau titik pada bidang yang terbagi menjadi 3. POI ada 4 titik, sedangkan interesting 

lines dibagi menjadi 2 garis horizontal dan 2 garis vertikal. Posisi POI sendiri berapa pada 

keempat garis atau titik yang berupa bagian mata dari objek atau objek itu sendiri.  

  



 

Gambar 3. 1. Contoh Rule Of Third Pada Fotografi 
Sumber : (Carrol, 2022) 

 

II. Centered Composition and Symmetry 

Simetris atau komposisi dengan objek yang diletakkan dengan membagi bidang 

gambar dengan cara rata kanan maupun kiri, sehingga objek terlihat simetris atau objek 

utama yang ingin diambil berada ditengah frame.  

  

 

Gambar 3. 2. Contoh Centered Composition and Symmetry 

Sumber : (Carrol, 2022) 
 

  



III. Frame Within the Frame 

Frame Within Frame adalah komposisi fotogradi yang mengarahkan mata untuk 

melihat apa yang ada di dalam frame dan mengesampingkan apa yang ada di luar frame, 

fungsinya komposisi ini untuk menggambarkan kedalaman dalam sebuah adegan, bingkai 

yang digunakan bisa dengan menggunakan berbagai elemen seperti jendela, lengkungan, 

atau cabang yang menjorok untuk membingkai pemandangan. Bingkai tidak harus 

mengelilingi seluruh pemandangan. 

 

 

Gambar 3. 3. Contoh Frame Within Frame 

Sumber : (Carrol, 2022) 
 

IV. Leading Lines 

Leading Lines merupakan komposisi fotografi yang menggunakan garis berbentuk 

nyata atau maya yang mengarahkan mata untuk melihat objek menjadi POI. Metode ini 

membantu mengarahkan mata untuk memusatkan perhatian pada elemen penting. Metode 

ini sangat cocok untuk mengambil gambar dengan unsur seperti jembatan, dinding, jalan, 

atau objek yang membentuk garis maya serta yang menuntun mata untuk melihat objek 

yang sebenarnya. 



 

Gambar 3. 4. Contoh Leading Lines 

Sumber : (Carrol, 2022) 
 

V. Pattern and Textures 

Pattern and Textures merupakan metode fotografi dengan komposisi menampilkan 

tekstur dari ojek yang difoto. Dengan menggunakan komposisi ini makan objek akan 

terlihat lebih detail. Contoh unsur yang dapat digunakan da;am komposisi ini seperti kayu, 

kuliy, guratan, aspal, tulang pada daun dan lain sebegainya. Untuk mendapatkan tekstur 

yang bagus maka dapat menggunakan metodemengambil objek foto dari jarak dekat. 

  

Gambar 3. 5. Contoh Pattern and Textures 

Sumber : (Carrol, 2022) 
 

VI. Diagonal and Triangles 

Diagonal and Triangles merupakan komposisi fotografi yang mengandung elemen garis 

diagonal, metode ini dapat membentuk dengan cara menarik garis diagonal dari sudut ke 

sudut lainnya, hingga membentuk segitiga, tujuannya agar gambar dapat lebih dinamis 

daripada hanya menggunakan garis lurus atau horizontal yang menyiratkan kekuatan, 

ketenangan dan stabilitas. Selain itu, menggabungkan garis diagobal dalam foto grafi 



menciptakan kesan Gerakan dan membantu mengarahkan mata ke subjek serta membantu 

menambah kedalam dan perspektif. 

  

Gambar 3. 6. Contoh Diagonal and Triangles 

Sumber : (Carrol, 2022) 
 

VII. Dept Of Field 

Dept of filed atau kedalaman bidang secara sederhana adalah seberapa banyak 

gambar yang berada dalam fokus. Secara teknis komposisi ini adalah jarak dalam gambar 

dimana objek tampak “dalam fokus yang dapat diterima” atau memiliki tingkat “ketajaman 

yang dapat diterima”. 

Ada beberapa faktor yang memengaruhi kedalaman bidang dalam fotografi, terlepas 

dari jenis kamera yang digunakan. Faktor – faktor tersebut adalah : panjang fokus, 

aperture, jarak kamera dengan subjek, dan ukuran sensor. 

Ada beberapa contoh kedalaman bidang atau dept of field dalam fotografi yaitu: 

1. Macro 

Fotografi makro adalah mengambil foto dari hal – hala yang sangat kecil dalam ukurang 

yang lebih besar dari aslinya. Contohnya foto besar seekor serangga. 

 

Gambar 3. 7. Contoh Dept Of Field Metode Macro 
Sumber : (MasterClass, 2021) 

  



2. Deep 

Depp merupakan kedalam bidang yang besar atau dalam yang menempatkan jarak yang 

lehih jauh ke dalam fokus. Fotografi lanskap adalah contoh yang baik dari contoh 

kedalam bidang dengan metode deep. 

 

Gambar 3. 8. Contoh Dept Of Field Metode Deep 

Sumber : (MasterClass, 2021) 
3. Shallow 

Shallow merupakan kedalam bidang yang dangkal, metode ini bagus untuk pemfokusan 

pada opsi yang lebih dekat dengan kamera. Contohnya adalah gambar bunga dari dekat. 

 

Gambar 3. 9.  Contoh Dept Of Field Metode Shallow 
Sumber: (Adobe, n.d.)  



4. Landscape 

Landscape merupakan metode dalam komposisi Dept Of Field yang mempunyai kedalam 

bidang yang sangat besar karena pada dasarnya semua objek dalam gambar tersebut 

ingin dijadikan fokus pada sebuah gambar. 

 

Gambar 3. 10. Contoh Dept Of Field Metode Landscape 

Sumber : (MasterClass, 2021) 
5. Close-up 

Pada metode Close-up gambar yang diambil memiliki kedalam bidang yang dangkal, 

dengan panjang fokus yang lebih panjang dan jarak subjek dengan kamera harus 

pendek atau dekat. 

 

Gambar 3. 11. Contoh Dept Of Field Metode Close-up 

Sumber : (MasterClass, 2021) 
  



6. Bokeh 

Bokeh merupakan  salah satu metode dept of field yang popular. Saaat memotret 

dengan metode bokeh, atur aperture pada lensa pada skala yang terendah. 

 

Gambar 3. 12. Contoh Depft Of Field Metode Bokeh 
Sumber : (MasterClass, 2021) 

VIII. Left To Right Rule  

Seperti teori yang mengatakan bahwa “membaca” gamabr dari kiri ke kanan sama 

dengan seperti membaca teks. Untuk alasan ini, disarankan bahwa setiap Gerakan yang 

digambarkan dalam sebuah foto harus mengalir dari kiri ke kanan.  

 

Gambar 3. 13. Contoh Left to Right Rule 

Sumber : (Carrol, 2022) 
 

  



IX. Color Composition 

Teori ini menggunakan color wheel ataupun keberagaman warna dalam satu gambar, 

contohnya Ketika memotret sunset dibagian awannya ada bagian yang bewarana orange 

(Warm tone) dan sebelah warna biru, itu menandakan ada keberagaman warna dalam satu 

gambar tersebut. 

 

Gambar 3. 14. Contoh Color Composition 

Sumber : (Travel Photograhy Guru, 2020) 
 

X. Breaking The Rules  

Komposisi ini menggunakan variasi dalam teori komposisi, tergantung dengan 

kreativitas dan komposisi apa saja yang cocok membuat gambar terlihat bagus, tetapi 

sebelum melakukan teori ini kita harus memahami teori sebelumnya. 

 

Gambar 3. 15. Contoh Breaking The Rules 

Sumber : (Nactwey & National Geographic, n.d.) 
  



LEMBAR KERJA 

Nama   : 

NIM  : 

Jenis Tugas : Praktek Individu  

Metode/Cara Pengerjaan Tugas: 

1. Tugas berupa PDF dan dipresentasikan  

3. Mengambil gambar dari masing – masing jenis Basic Composition, berikan judul dan 

jelaskan teknik yang digunakan serta objek yang menjadi fokus gambar. 

Contoh Tugas: 

1. Breaking The Rules 

 

  

Judul Foto  

Penjelasan Teknik dan Objek yang menjadi 

fokus gambar  



Modul 4  : Dasar Sinematografi: Pengenalan Kamera Video  

Materi Estimasi Waktu Capaian Pembelajaran 

a. Pengenalan Kamera 

Video berupa Handycam 

Materi : 60 Menit 

Praktikum : 110 Menit 

a. Mahasiswa mampu 

memahami dan 

mengaplikasikan dasar 

sinematografi mengenai 

pengenalan fungsi panel 

dan bagian – bagian dari 

kamera video berupa 

Handycam. 

 

Materi 4 

 Materi ini membahas tentang pengenalan kamera video pada dasar sinematografi, 

pada praktiknya menggunakan kamera video jenis Handycam Sony HDR-CX405. Pada modul 

ini dijelaskan mengenai fungsi dan cara penggunaan Handycam Sony HDR-CX405. 

 

Gambar 4. 1. Handycam Sony HDR-CX405 
Sumber: (Sony Corporation, 2015) 

 

1. Bagian – bagian dan control bagian depan/ atas 

 

Gambar 4. 2. Bagian depan/atas 
Sumber: (Sony Corporation, 2015) 

 

NO NAMA BAGIAN KAMERA 

1 Tuas Pembesaran  

2 Tombol Photo 

3 Tanda N 

NFC (Near Field Communication) 

4 Tombol Lensa Cover  

5 Lensa (Lensa Zeiss) 

6 Mikrofon yang terpasang di dalam  



2. Bagian – bagian dan kontrol   (layar LCD) 

 

Gambar 4. 3. Bagian - bagian dan 
kontrol (layar LCD) 
Sumber: (Sony Corporation, 2015) 

 

3. Bagian – bagian dan kontrol (samping) 

 

Gambar 4. 4. Bagian - bagian dan 
kontrol (samping) 
Sumber: (Sony Corporation, 2015) 

 

 

  

NO NAMA BAGIAN KAMERA 

1 Tuas Projector Focus  

2 Multi selector 

3 
Tombol  (Tampilan Gambar) 

4 Tombol Projector 

5 Layar LCD 

Bila memutar panel LCD 180 derajat 

ke sisi lensa, Anda dapat menutup 

layar LCD dengan layar LCD 

menghadap keluar 

6 Lensa proyektor 

NO NAMA BAGIAN KAMERA 

1 Speaker 

2 Celah kartu memori 

3 Lampu akses kartu memori 

Bila lampu menyala atau berkedip, 

produk ini sedang membaca atau 

menulis data  

4 Jack HDMI OUT 

5 Jack Projector In 



4. Bagian – bagian dan kontrol (belakang/bawah) 

 

 

Gambar 4. 5. Bagian - bagian dan kontrol 
(belakang/bawah 1) 
Sumber: (Sony Corporation, 2015) 
 

 

Gambar 4. 6. Bagian - bagian dan kontrol (belakang/bawah 2) 
Sumber: (Sony Corporation, 2015) 
 

 

5. Cara Merekam Film  

 

NO Langkah Penggunaan Penjelasan Gambar  

1 Buka Penutup Lensa 

 

NO NAMA BAGIAN KAMERA 

1 Lampu Power/CHG (pengisian daya) 

2 Tombol Start/Stop 

3 Kait untuk selempang 

4 Terminal Multi 

5 Tali Pegangan  

6 Kabel USB Terpasang (Built-in) 

NO NAMA BAGIAN KAMERA 

1 Penerima Tripod  

2 Penutup baterai 

3 Tuas Pelepas baterai  

4 Baterai  



NO Langkah Penggunaan Penjelasan Gambar  

2 Buka layar LCD dan 

nyalakan Handycam  

 

3 Tekan START/STOP 

untuk mulai perekaman  

• Untuk menghentikan 

perekaman, tekan 

START/STOP kembali.  

 

Catatan  

1. Bila menutup layar LCD selama perekaman film, maka otomatis akan berhenti 

merekam  

2. Waktu untuk merekam film secara terus – menerus maksimum sekitar 13 jam  

3. Bila sebuah file fim AVCHD lebih dari 2 GB, file film berikutnya dibuat secara otomatis  

4. Bila sebuah file film MP4 lebih dari 4 GB, file film berikutnya dibuat secara otomatis  

 

6. Pembesaran (Zoom in) 

 

NO Langkah Penggunaan Penjelasan Gambar  

1 Gerakkan tuas pembesaran untuk 

memperbesar atau memperkecil 

ukuran gambar. 

W: Rentang tampilan yang lebih 

lebar (Sudut lebar) 

T: tampilan dekat (Telefoto) 

• Gerakkan tuas pembesaran 

sedikit untuk pembesaran secara 

perlahan. Gerakkan lebih jauh 

untuk melakukan pembesaran 

dengan cepat  

 

 

  



Catatan  

1. Pastikan untuk meletakkan jari di tuas pembesaran. Bila melepaskan jari dari tuas 

pembesaran, bunyi operasi tuas pembesaran juga akan terekam.  

2. Jarak minimum yang mungkin antara handycam dan subjek sambil mempertahankan 

fokus yang tajam adalah sekitar 1cm untuk sudut lebar dan sekitar 80 cm untuk 

telefoto.  



LEMBAR KERJA 

Nama   : 

NIM  : 

Jenis Tugas : Praktek Individu  

Metode/Cara Pengerjaan Tugas: 

1. Menyebutkan nama bagian dan fungsi dari bagian kamera video yang ditunjuk. 

4. Mempraktekkan cara memegang kamera dan menggunakannya secara sederhana. 

 

  



Modul 5  : Dasar Sinematografi: Teknik Pengambilan Video 

Materi Estimasi Waktu Capaian Pembelajaran 

a. Pengenalan Teknik 

Pengambilan Video 

Materi : 60 Menit 

Praktikum : 110 Menit 

a. Mahasiswa mampu 

memahami dan 

mengaplikasikan dasar 

sinematografi mengenai 

teknik pengambilan 

video  

 

Materi 5  

I. Teknik Pengambilan Video Berdasarkan Sudut Pengambilan Gambar/Angle  

1. Frog Eye  

Teknik Shooting ini mengambil gambar dengan posisi kamera disejajarkan dengan 

bagian alas/bawah obyek dan posisinya lebih rendah dari dasar objek. Hasil gambar 

yang diambil akan menjadi sangat besar. Objek gambar yang diambil memiliki kesan 

agung, angkuh maupun kokoh. 

2. Low Angle  

Merupakan Pengambilan gambar dengan sudut arah bawah obyek yang memberikan 

kesan obyek membesar.  

3. Eye Level  

Teknik ini mengambil posisi sejajar dengan objek. Dengan teknik ini maka gambar yang 

direkan menunjukkan tangkapan pandangan mata orang yang berdiri sejajar dengan 

objek. Ketinggal dan besarnya obyek menjadi sama dengan subjek dan disebut juga 

teknik normal shoot.  

4. High Angle  

Teknik ini mngemabil gambar dari posisi atas objek, sehinga hasil objek shooting 

menjadi lebih kecil. Hasil gamabr yang diambil menunjukkan kesan dramatis dan 

terkesan kerdil.  

5. Bird Eye 

Teknik Bird Eye (mata burung) merupakan teknik shooting dengan memposisikan juru 

kamera di atas ketinggian dalam merekam objek. Hasilnya gambar yang tampak 

menunjukkan lingkungan sekitar lebih luas. Benda – benda lainnya di sekitar objek juga 

akan tampak dalam ukuran kecil. 

  



6. Slanted 

Teknik shooting ini mengambil sudut yang tidak frontal dari depan ataupun dari sapung 

objek. Tapi mengambil sudut 45 derajat terhadap objek. Hasilnya objek lain akan masuk 

dalam rekaman.  

7. Over Shoulder  

Teknik shooting ini mengambil gambar dari arah belakang bahu objek. Akibatnnya obyek 

hanya nampak bagian bahu atau kepalanya saja. Biasanya teknik ini dipakai untuk 

menunjukkan bahwa objek sedang melihat sesuatu ataupun sedang berbincang – 

bincang.  

 

II. Teknik Pengambilan Gambar Video Berdasarkan Ukuran Gambar 

1. Extreme Close Up (ECU) 

Merupakan pengambilan gambar dari jarak sangat dekat, hingga pori – pori kulit pun 

bisa terlihat. Tujuannya agar objek menjadi sangat – sangat jelas.  

2. Big Close Up (BCU) 

Pengambilan gambar dari atas kepala hingga dagu objek, tujuannya untuk menunjukkan 

ekspresi dari objek. 

3. Close Up (CU) 

Close Up dilakukan dengan mengambil atas kepala hingga bawah leher dari objek, 

Tujuannya agar wajah objek nampak lebih jelas.  

4. Medium Close Up (MCU) 

Teknik ini menyorot dari kepala hingga dada. Teknik ini bertujuan untuk mempertegas 

gambaran profil seseorang.  

5. Medium Shot (MS) 

Teknik ini menyorot mulai dari kepala hingga pinggang objek. Tujuannya agar sosok 

orang tersebut semakin jelas.  

6. Full Shot (FS) 

Teknik ini memperlihatkan seluruh tubuh objek, dari kepala hingga kaki.  

7. Long Shoot (LS) atau Wide Shot 

Teknik ini menunjukkan objek sekaligus latar belakangnya. Walaupun tidak sepenuhnya 

full  atau masih ada jarak pemeran dengan fram seperti dibagian atau kepala atau di 

bawah kaki. Teknik ini bertujuan untuk memperlihatkan hubungan pemeran dengan 

kondisi lingkungannya 

 

 



8. Extreme Long Shoot / Extreme Wide Shot  

Teknik ini digunakan untuk membangun suasana sebuah adegan, dimana tipe ini 

pemeran hamper tidak muncul dalam visual karena penggunaan sudut pandang lebar 

yang sangat ekstrim. Teknik ini juga biasanya digunakan unutk memeperlihatkan latar 

dari sebuat adegan atau video  

9. One Shoot (1S) 

Teknik shooting ini hanya untuk menampilkan satu objek saja.  

10. Two Shoot (2S) 

Teknik shooting ini menampilkan dua objek yang lebih terlibat percakapan   

11. Three Shoot (3S) 

Teknik shooting ini menampilan tiga objek dalam satu frame.  

12. Group Shoot (GS) 

Teknik ini mengambil gambar kumpulan orang, seperti adegan pasukan, kerumunan 

orang dan sebagainya.  

 

III. Tenik Pengambilan Video Berdasarkan Pergerakan Kamera  

1. Zoom  

Zoom atau zooming merupakan gerakan paling dasar, yakni dengan cara mendekati 

atau menjauhi objek secara optik dengan membarui panjang focal lensa asal sut padang 

sempit ke sudut pandang lebar atau sebaliknya.  

Gambar yang dihasilkan berasal Gerakan ini ialah subjek seolah-olah mendekat (Zoom 

in) dan subjek seolah olah menjauh (Zoom out).  

Teknik ini dilakukan untuk memperjelas sesuatu yang lebih penting, baik pada subjek 

maupun sebuah insiden. 

2. Dolly  

Dolly (Track) adalah teknik pengambilan gambar mendekati atau menjauhi subjek 

menggunakan pergerakan kamera di atas tripot atau dolly. Pengambilan gambar 

menggunakan teknik ini biasanya untuk seolah-olah kamera menjadi mata penonton 

dan membawa penonton pada sebuah peristiwa didalam suatu adegan sehingga 

penonton merasa ikut terlibat pada adegan tersebut. 

 Dolly in atau kamera mendekati subjek, biasanya dipergunakan untuk membawa 

perasaan penonton untuk lebih berani, dan siap menghadapi tantangan. Sedangkan 

dolly out atau kamera menjauhi subjek mampu digunakan untuk mewakili perasaan 

kecewa, takut dan merasa inferior.  



 Sebagaimana penggunaan zoom in, Gerakan dolly in yang mendekati subjek dapat 

membawa penonton pada satu titik sentra perhatian, perasaan tegang dan menciptakan 

rasa keingintahuan. Sedangkan proses pelepasan ketegangan dapat dilakukan dengan 

dolly out. 

3. Panning 

Pan atau panning ialah gerakan kamera menoleh ke kiri (Pan Left) serta ke kanan (Pan 

Right). Gerakan yang ada pada teknik ini juga secara umum adalah Follow pan, yakni 

gerakan kamera mengikuti subjek beranjak (travelling), hal ini bertujuan untuk 

mempertahankan komosisi visual supaya tetap proporsional pada frame.  

4. Crab 

Crab atau crabbing adalah gerakan kamera secara lateral atau menyamping, berjalan 

sejajak menggunakan subjek yang sedang berjalan, gerakan crab hamper sama 

menggunakan dolly, perbedaannya hanya di arah gerakan kamera. Bila dolly dinamis 

maju mundur maka crab bergerak ke kiri (crab left) dan ke kanan (crab right). 

5. Tilt  

Tilt atau tiling adalah gerakan kamera secara vertikal, mendongak dari bawah ke atas 

(Tilt up) maupun berasal atas ke bawah (Tilt down). Gerakan tilting banyak digunakan 

untuk menggiring mata penonton pada kegiatan terntentu pada subjek, misalnya shot 

dimulai menggunakan paras Wanita menangis menunduk ke bawah, kamera melakukan 

tilt down, dan shot terakhir berkahir di jemarinya yang bergetar sedang membaca atau 

membalas pesan dari sesorang, mungkin sedang diputus pacarnya ataupun adegan bisa 

dilakukan sebaliknya.  

6. Pedestal (Ped) 

Pedestal artinya gerakan kamera pada atas pedestal yang mampu dinaik turunkan. 

Pedestal up merupakan gerakan kamera yang dinaikkan, sedangkan pedestal down 

adalah gerakan kamera yang diturunkan,  

7. Arc  

Arc adalah gerakan kamera memutar mengintari objek berasal kiri ke kanan atau 

sebaliknya.  

8. Follow 

Follow ialah gerakan kamera mengikuti objek yang beranjak, bisa menggunakan pan, 

tilt, ped atau yang lainnya, untuk mendapatkan gerakan yang lebih dinamis mampu juga 

menggunakan crane atau menggunakan handheld. 

 

 



9. Fading  

Fading adalah pergantian gambar secara perlahan. Fade in jika gambar muncul dan 

fade out jika gambar menghilang serta cross fade jika gambar 1 dan 2 saling 

menggantikan secara bersamaan.  

 

IV. Teknik pengambilan gambar hanya objek yang bergerak. 

Teknik ini digunakan dalam posisi kamera diam tetapi objek yang bergerak. Diantaranya 

ada 1) objek bergerak sejajar dengan kamera, 2) walk in dimana objek bergerak mendekati 

kamera, dan 3) walk away yaitu objek menjauhi kamera.  

 

V. Teknik pengambilan gambar dengan memanfaatkan cahaya ataupun properti 

Teknik ini tidak hanya mengadalkan sudut pengambilan, ukuran gambar, gerakan 

kamera dan objek tetapi unsur – unsur lain seperti cahaya, property dan lingkungan, 

tujuannya untuk menghasilkan kesan yang lebih dramatis. 

1. Backlight Shot 

Teknik pengambilan gambar terhadap objek dengan pencahayaan dari belakang. 

2. Reflection Shot  

Teknik pengambilan gambar ini tidka diarahkan langsung ke objeknya tetapi dari 

cermin/air yang dapat memantulkan bayangan objek.  

3. Door Frame Shot  

Teknik ini diambil dari luar pintu sedangkan adegan ada di dalam ruangan. 

4. Artificial Framing Shot  

Teknik ini diambil menggunakan property seperti daun atau ranting diletakkan di depan 

kamera sehingga seolah – olah objek diambil dari balik ranting tersebut.  

 

  



LEMBAR KERJA 

Nama   : 

NIM  : 

Jenis Tugas : Praktek Kelompok  

Metode/Cara Pengerjaan Tugas: 

1. Membuat kelompok yang terdiri dari 3-4 orang  

2. Memilih 3-4 jenis teknik pengambilan gambar  

3. Membuat sebuah video sederhana menggunakan teknik tersebut 

5. Mempraktekkan secara langsung bagaimana pengambilan gambar dilakukan 

menggunakan kamera video (handycam) 

  



Modul 6 : Dasar Sinematografi: Pembuatan Story Board 

Materi Estimasi Waktu Capaian Pembelajaran 

a. Pengenalan dan 

Pembuatan Story Board 

Materi : 60 Menit 

Praktikum : 110 Menit 

a. Mahasiswa mampu 

memahami dan 

mengaplikasikan dasar 

sinematografi mengenai 

Story Board 

 

Materi 6  

Salah satu tahapan penting dalam produksi film adalah membuat storyboard, setelah 

sutradara dan pengarah fotografi membahas sebuah adegan mereka kemudian bertemu 

dengan artis storyboard untuk menterjemahkan gagasan mereka dalam gambar. 

I. Definisi Story Board 

Storyboard adalah sketsa gambar yang disusun berurutan sesuai dengan naskah, 

dengan storyboard kita dapat menyampaikan ide cerita kita kepada orang lain dengan lebih 

mudah, karena kita dapat menggiring khayalan seseorang mengikuti gambar-gambar yang 

tersaji, sehingga menghasilkan persepsi yang sama pada ide cerita kita. 

Storyboard juga sering disebut papan cerita. Storyboard berfungsi untuk 

menggambarkan alur cerita mulai dari awal hingga akhir dan merencanakan proses 

pengambilan gambar agar lebih terstruktur. Selain itu, storyboard berfungsi sebagai 

pedoman proses produksi hingga proses pengeditan video, sehingga lebih mudah dan 

hasilnya sesuai dengan yang direncanakan.  

 

II. Isi Story Board 

1. Informasi Karakter dan pergerakan karakter 

2. Informasi komunikasi antar karakter (jika ada) 

3. Durasi antara frame di story board 

4. Lokasi, keadaan dan perlakukan kamera (angle kamera, pergerakan kamera) 

 

III. Alasan Penggunaan Story Board 

1. Membantu menjelaskan konsep 

2. Membantu komunikasi antar tim 

3. Mempunyai ide dasar dari konsep awal 



4. Membuat storyboard dan sketch kasar yang akan dibuat, karakter utama dan aksi-aksi 

yang nantinya terkandung di dalamnya 

5. Membantu memikirkan detil konsep dan alam keseluruhan dari cerita yang akan dibuat. 

6. Menggabungkan konsep menjadi dokumen desain (semacam moviescript). 

 

IV. Manfaat Story Board 

1. Mengorganisir proses pengambilan gambar  

Storyboard dapat mempermudah proses pengambilan gambar, agar lebih efektif dan 

efisien, sehingga dapat membantu penentuan pengambilan angle  gambar dan 

mengetahui bagan selanjutnya. 

2. Memudahkan dalam membuat dan memahami alur cerita 

Storyboard berisikan sketsa gambar berurutan sesuai naskahm sehingga mempermudah 

proses pembuatan pemahaman alur ceritanya, hal ini mempermudah seluruh tim untuk 

memiliki persepsi yang sama dalam proses pengambilan gambar dan pembuatan video 

sesuai dengan yang diinginkan. 

3. Dapat mengetahui kesalahan pada bagian awal  

Pembuatan storyboard dapat memudahkan dalam mencari tahun kesalahan pada teks 

narasi, penggunaan media, dan detail lainnya, sehingga dapat menghemat waktu, biaya 

dan tenaga.  

 

V. Cara Membuat Storyboard  

Dalam buku Pengembangan Bahan Ajar (2019) karya Nana, dituliskan lima cara 

pembuatan storyboard, yakni: 

1. Penentuan tema  

Pada awal pembuatan storyboard harus menentukan tema, tema ini berpengaruh pada 

naskah, sketsa gambar, penggunaan media, penggunaan property, dan lain-lain.  

2. Pembuatan naskah  

Setelah tema ditentukan, naskah harus dibuat secara rinci. Isi naskah yang dibuat 

memuat teks dialog, keterangan dan hal lainnya yang berkaitan dengan pembuatan 

video, film atau animasi.  

3. Menentukan poin penting 

Poin penting berkaitan dengan naskah dan tema yang telah ditentukan sebelumnya. 

Biasanya poin penting ini berisikan ide atau konsep yang nanti akan dibuat menjadi 

storyboard.  

4. Menentukan gambaran sketsa kasar dalam alur cerita storyboard  



Setelah tiga tahapan sudah dilakukan maka dapat disusun gambaran sketsa kasar. 

Pembuatan sketsa kasar ini disertai dengan penjelasan atau keterangan pembuatan 

audio visual.  

5. Gambaran direalisasikan dengan nyata 

Setelah sketsa kasar dibuat, maka storyboard dapat dibuat dalam bentuk yang lebih rapi 

dan jelas. Untuk membuat storyboard dapat menggunakan aplikasi khusus atau lain 

sebagainya.  

 

VI. Contoh Storyboard  

 

Gambar 6. 1. Contoh Story Board 

 



 

Gambar 6. 2. Contoh Story Board 

 

Gambar 6. 3. Contoh Story Board 

 

 

  



LEMBAR KERJA 

Nama   : 

NIM  : 

Jenis Tugas : Praktek Individu  

Metode/Cara Pengerjaan Tugas: 

1. Membuat Story board sebuah video berdurasi maksimal 3 menit 

2. Format Storyboard dalam bentuk pdf dan upload di OLU 

3. Beri nama File : Nama_NIM_P2MK_Story board 

4. Bebas menggunakan template story board apa saja, isi storu board memuat: 

a. Scene 

b. Sequence 

c. Board (Ilustrasi gambar) 

d. Durasi 

e. Naskah (Narasi, pergerakan kamera atau teknik pengambilan gambar) 

Contoh Tugas: 

 

 



Modul 7  : Dasar Sinematografi: Pengenalan Aplikasi Editing 

Video 

Materi Estimasi Waktu Capaian Pembelajaran 

a. Pengenalan aplikasi 

Filmora X  

  

Materi : 70 Menit 

Praktikum : 100 Menit 

a. Mahasiswa mampu 

memahami dan 

mengaplikasikan dasar 

sinematografi mengenai 

teknik dasar editing 

video menggunakan 

aplikasi Filmora X   

 

Materi 7  

I. PERSYARATAN WONDERSHARE FILMORA X UNTUK WINDOWS 

1. OS yang Didukung : Windows 7/Windows 8.1/Windows 10/Windows 11 ( 64 bit OS). 

2. Prosesor : Intel i3 atau prosesor multicore yang lebih baik, 2GHz atau lebih. (Intel 6th 

Gen atau CPU yang lebih baru direkomendasikan untuk video HD dan 4K). 

3. RAM : 4 GB RAM (8GB diperlukan untuk video HD dan 4K). 

4. Grafis : Intel HD Graphics 5000 atau lebih baru; NVIDIA GeForce GTX 700 atau lebih 

baru; AMD Radeon R5 atau lebih baru. 2 GB vRAM (4GB diperlukan untuk video HD dan 

4K). 

5. Disk : Setidaknya 10GB ruang hard-disk kosong untuk penginstalan (SSD-Solid State 

Disk direkomendasikan untuk mengedit video HD dan 4K). 

6. Internet : Koneksi internet diperlukan untuk pendaftaran software dan akses ke 

layanan online seperti Filmstock. 

Tipe Format Kontainer 

Format Video File video MPEG-1/2: (.mpg, .mpeg, .m1v, .m2v) 

File video MPEG-4: (.mp4, .m4v, .3gp, .3g2, .3gp2) 

File Movie QuickTime: (.mov dienkode dengan codec MPEG 4 atau 

MJPEG saja) 

File Camcorder: (.dv, .mod, .tod, .mts, .m2ts, .m2t) 

Video Flash: (.flv, .f4v) 



 

 

II. FORMAT INPUT YANG DIDUKUNG  

 

 

III. FORMAT OUTUPUT YANG DIDUKUNG 

Tipe Format Kontainer 

Media Windows: (.wmv, .asf) 

Audio Visual Interleave (.avi) 

File Video Matroska: (.mkv dienkode dengan codec MPEG 4 atau 

MJPEG saja) 

File Video HTML5: (.mp4, .webm, .ogv) 

Judul DVD yang tidak dienkripsi: (.vob, .vro) 

Format Audio .mp3, .m4a, .wav, .wma, .ogg, .flac, .aif, .aiff 

Format Foto .jpg, .png, .bmp, .gif, .tif, .tiff 

Tipe Format Kontainer 

Format Video File video MPEG-1/2: (.mpg, .mpeg, .m1v, .m2v) 

File video MPEG-4: (.mp4, .m4v, .3gp, .3g2, .3gp2) 

File Movie QuickTime: (.mov dienkode dengan codec MPEG 4 atau 

MJPEG saja) 

File Camcorder: (.dv, .mod, .tod, .mts, .m2ts, .m2t) 

Video Flash: (.flv, .f4v) 

Media Windows: (.wmv, .asf) 

Audio Visual Interleave (.avi) 

File Video Matroska: (.mkv dienkode dengan codec MPEG 4 atau 

MJPEG saja) 

File Video HTML5: (.mp4, .webm, .ogv) 

Judul DVD yang tidak dienkripsi: (.vob, .vro) 

Format Audio .mp3, .m4a, .wav, .wma, .ogg, .flac, .aif, .aiff 

Format Foto .jpg, .png, .bmp, .gif, .tif, .tiff 



Tipe Format Kontainer atau profil SNS/Perangkat 

Format Video/audio biasa .mp4, .wmv, .avi, .mov, .f4v, .mkv, .ts, .mpg, .3gp, 

.webm, .gif, .mp3 

4K .mp4, .mov, .mkv 

Perangkat iPhone, iPad, Apple TV, iPod, Galaxy S, Android Generic, 

Nexus,PS4, Xbox one, Wii, Sony TV, Smartphone 

Jejaring Sosial YouTube, Vimeo 

DVD DVD disc, folder DVD, file gambar ISO disc 

* Beberapa format codec di atas mungkin perlu didukung oleh sistem. 

 

IV. PENGENALAN TAMPILAN AWAL APLIKASI WONDERSHARE FILMORA X  

Jika sudah menginstall aplikasi filmora, untuk membuka aplikasi filmora, klik 2 kali pada 

ikon filmora, lalu tunggu sampai filmora terbuka 

 

Klik 2 Pada ikon tersebut untuk membuka filmora  

 

 

 

 

Tampilan proses untuk membuka 

filmora  

 

 

 

Setelah tampilan tersebut hilang maka akan terbuka tampilan untuk memulai lembar 

kerja pada filmora, pada bagian tersebut akan ada beberapa fitur yaitu: 1) Tampilan untuk 

memilih rasio ukuran video pada lembar kerja, 2) pilihan untuk memulai project baru (new 

project) atau membuka project yang sudah dibuat sebelumnya (open project), 3) tampilan 

untuk project yang telah dibuat dan disimpan. 



 

 Untuk rasio ukuran video yang digunakan pada umumnya menggunakan 

ukuran 16:9 (Widescreen), tapi dapat diatur sesuai kebutuhan dengan cara klik pada tanda 

panah kebawah disamping rasio ukuran video. 

 

Pada pembahasan panduan praktikum ini digunakan rasio 16:9 (widescreen) lalu klik 

new project, setelah memilih rasio video makan akan muncul tampilan lembar kerja, dan 

ada beberapa bagian dalam tampilan lembar kerja yaitu : 1) Menu Editing : berisikan 

menu toll atau alat yang digunakan untuk membantu dalam editing video, 2) Halaman 

Import Media: tempat untuk media yang akan digunakan sebagai bahan video, 3) 

Timeline: Tempat untuk melakukan editing video, 4) Preview:  layar untuk menampilkan 

media, 5) Preview Tools: berisikan peralatan untuk mengatur preview media yang 

dibutuhkan. 

 

1 

2 
3 

Klik 

pada 

area 

tersebut 

untuk 

melihat 

rasio 

video 

yang lain 



 

 

V. PENGENALAN MENU DAN FITUR EDITING PADA WONDERSHARE FILMORA X 

1. Fitur Menu Utama   

 

Nama Menu Ikon Menu Fungsi 

Media  

 

Menu media ini berfungsi untuk mengimport file 

video, audio ataupun gambar yang dibutuhkan. 

Audio 

 

Pada menu ini berisikan audio berupa music 

ataupun music efek yang dapat digunakan untuk 

kebutuhan video 

Titles 

 

Pada menu ini berisikan tulisan dan efeknya yang 

dapat digunakan dalam kebutuhan video, elemen 

title dari sebuah video yang disediakan meliputi: 

Opener, Title, Lower Title, Sub Title dan End 

Credits. 

Transition 

 

Pada menu ini disediakan transisi yang dapat 

digunakan sebagai efek peralihan antar klip video. 

Effects 

 

Pada menu ini disediakan effect yang dapat 

digunakan, pada fitur filter digunakan untuk 

memberikan efek warna, fitur overlay memberikan 

efek lain dan elemen tambahan dalam video dan 

LUT untuk memberikan efek cinematic pada video. 

1 

2 

3 

4 

5 



Nama Menu Ikon Menu Fungsi 

Elements 
 

Pada menu ini berfungsi untuk menambahkan 

elemen seperti ikon ataupun elemen yang dapat 

digunakan untuk membantu menjelaskan maksud 

dari video yang dibuat. 

Split Screen 
 

Menu ini berfungsi untuk memadukan 2 atau lebih 

video dalam satu frame. 

 

2. Fitur Tambahan Editing 

 

Nama Fitur Ikon Menu Fungsi 

Undo dan 

Redo  

berfungsi untuk mengubah menjadi perintah 

sebelumnya (undo) ataupun setelahnya (redo) 

Delete 
 

Untuk menghapus media  

Split 
 

Untuk memisahkan media menjadi 2 bagian atau 

lebih  

Crop 
 

Untuk mengatur ukuran gambar menjadi lebih kecil  

Advanced 

Color Tool  
Untuk mengatur warna pada klip video  

Green Screen 
 

Untuk merubah background video sesuai dengan 

layar yang dibutuhkan  

Speed 
 

Untuk mengatur kecepatan video (lebih lambat atau 

lebih cepat) 

Key Framing 
 

untuk menambahkan animasi pada video seperti 

prubahan posisi, rotasi, skala, keburaman klip dan 

lainnya 

Edit 

Tambahan  
Berisikan pengaturan full feature editing  

 

 

 



3. Fitur Media Preview 

 

Pada fitur Media Preview dibagi menjadi 2 bagian utama, yang pertama Media Preview 

merupakan layar untuk melihat hasil media yang sudah dibuat dan yang kedua adalah 

Preview Toolbars yang berisikan menu unutk membantu dalam penyesuaian tampilan 

untuk melihat hasil dari media yang dibuat, fitur pada preview toolbars meliputi: 

Nama Fitur Ikon Menu Fungsi 

Backward  

Berfungsi untuk kembali atau mundur pada 

tampilan preview media sebelumya. 

Forward 
 

Berfungsi untuk maju menuju tampilan preview 

media selanjutnya 

Play 
 

Berfungsi untuk memulai memainkan media 

yang sudah dibuat 

Stop  

Berfungsi untuk memberhentikan preview 

media. 

Playback 

Quality  

Berfungsi untuk mengatur kualitas pada 

tampilan ketika preview. 

Preview 

Quality and 

Display 

Setting 

 

Berfungsi untuk mengatur kualitas dan tampilan 

ketika preview. 

Snapshot 
 

Berfungsi untuk mengambil snap atau gambar 

sesuai tampilan video yang dipilih pada saat 

preview. 

Volume 
 

Berfungsi untuk mengatur besar dan kecilnya 

suara pada saat preview. 

Layar 

Media 

Preview  

Preview 

Toolbars  



Nama Fitur Ikon Menu Fungsi 

Full Screen 
 

Berfungsi untuk melihat preview media secara 

layar penuh 

 

4. Fitur Tambahan Untuk Proses Preview dan Editing Media 

 

Nama Fitur Ikon Menu Fungsi 

Render 

Preview  

Berfungsi untuk rendering video agar hasil 

lebih halus ketika preview. 

Add Mark 
 

Untuk memberikan tanda pada bagian 

video pada timeline 

Record a 

Voiceover  

Untuk menambahkan suara yang dpat 

direkam secara langsung dari aplikasi 

filmora 

Audio Mixer 
 

Untuk melakukan pengaturan mixing audio 

dapada video atau audio itu sendiri 

Zoom to Fit 

Timeline  

Untuk mengatur ukuran besar media agar 

sesuai pada timeline 

Zoom in dan 

Zoom out  

untuk mengatur ukuran besar kecil media 

pada timeline 

Audio Meter 
 

Untuk menjangkau apakah audio aktif atau 

tidak pada media yang diputar 

 

  



5. Timeline / Lembar Kerja  

 

 

 

 

 

Pada Timeline atau lembar kerja dibagi menjadi 3 bagian yaitu : 

a. Tools  : pada bagian ini berisikan Manage Track ( )yaitu alat 

bantu untuk menambahkan layer video atau audio pada timeline dan 

Auto Ripple On ( )yang berfungsi mengisi atau menggabungkan dan mengisi 

jika ada kolom yang kosong pada timeline. 

b. Time : Pada bagian ini berisikan waktu untuk melihat durasi dari media yang 

dibuat. 

c. Timeline: Pada bagian ini berfungsi sebagai tempat media diletakkan untuk 

dilakukan editing. 

  

Time Tools 

Timeline  



Modul 8  : Dasar Sinematografi: Teknik Editing Video 

Materi Estimasi Waktu Capaian Pembelajaran 

a. Teknik Dasar Editing 

Video 

b. Teknik Dasar Editing 

Audio Dalam Video 

c. Teknik Dasar Pemberian 

Efek Pada Video  

Materi : 70 Menit 

Praktikum : 100 Menit 

a. Mahasiswa mampu 

memahami dan 

mengaplikasikan dasar 

sinematografi mengenai 

teknik dasar editing video 

menggunakan aplikasi 

Filmora X   

 

I. Membuat Video 

1. Import Media  

Ada beberapa cara untuk import media dari file computer yaitu: 

a. Cara 1 

Pada bagian import yang masih kosong, untuk mengimport media hanya klik atau 

drop pada ikon yang berada di tengah halaman import → Pilih Media → Open → 

media sudah ter-import.  

1) Klik atau drop pada ikon yang berada di tengah halaman impor

 

2) Pilih Media yang ingin digunakan → Open 

 



3) Media sudah ter-import. 

 

 

b. Cara 2 

Pilih Menu File → Import Media →Pilih Sumber media → Pilih Media → Open → media 

sudah ter-import.  

Note: Pada contoh dibawah ini sumber media yang dipilih adalah Import Media Files 

1) Pilih Menu file  

  

2) Pilih Import Media →Pilih Media Files 

 



3) Pilih Media yang ingin digunakan → Open 

 

4) media sudah ter-import. 

 

 

2. Preview Media Import  

Cara  : Klik 2 kali pada media yang ingin dilakukan preview → media akan 

terlihat di layar Preview. 

a. Klik 2 kali pada media yang ingin dilakukan preview 

 

  

Klik 2 

Kali 



b. Media akan terlihat di layar Preview. 

 

 

3. Add Project (Video dan Gambar) ke dalam Timeline atau Lembar Kerja 

a. Cara 1 

Pada Media yang dipilih klik (+) → Project akan masuk kedalam Timeline. 

1) Pada Media yang dipilih klik (+) 

 

2) Project akan masuk kedalam Timeline. 

 

 

  

Klik (+) 



b. Cara 2  

Drag Project ke timeline  → Project akan masuk kedalam Timeline. 

1) Drag Project ke timeline   

 

2) Project akan masuk kedalam Timeline. 

 

 

4. Add Project (Audio) ke dalam Timeline atau Lembar Kerja 

Untuk Audio dapat dipilih dari menu utama Audio atau import dari file computer, untuk 

cara add project media ke dalam timeline sama seperti add video atau gambar, tetapi 

harus diperhatikan penempatan audio berada pada lembar kerja yang mempunyai ikon 

→          

 

  



5. Editing Video 

a. Cut Media (Video, Gambar atauAudio) 

Klik Pada video/gambar/audio yang ingin di cut → arahkan pada waktu bagian yang 

ingin di cut → klik ikon gunting yang warna merah→ video sudah di cut 

1) Klik Pada video/gambar/audio yang ingin di cut → arahkan pada waktu bagian 

yang ingin di cut 

 

2) klik ikon gunting yang warna merah→ video sudah di cut 

           

 

  



b. Mengatur Video 

Klik 2 kali pada video pada timeline yang ingin diatur → pilih menu yang ingin diatur 

pada video (Video, Audio, Color ataupun Animation) → silahkan atur video yang 

diinginkan. 

 

c. Mengatur Audio  

Klik 2 kali pada Audio pada timeline yang ingin diatur → silahkan atur video yang 

diinginkan. 

 

  



d. Mengatur Color Correction Pada Video  

Klik pada video atau objek yang diinginkan → klik kanan → klik Color Collection → 

silahkan pilih warna yang diinginkan (Preset: warna akan otomatis disesuaikan seperti 

contoh yang ada, Adjust : warna akan disesuaikan satu per satu secara detail sesuai 

dengan kebutuhan. 

1) Klik pada video atau objek yang diinginkan → klik kanan → klik Color Collection 

 

2) Silahkan pilih warna yang diinginkan (Preset: warna akan otomatis disesuaikan 

seperti contoh yang ada, Adjust : warna akan disesuaikan satu per satu secara 

detail sesuai dengan kebutuhan → jika sudah pilih OK. 

 

 

  



e. Mengatur Animasi Pada Video atau Gambar  

Klik 2 kali pada gambar atau video yang ingin diberikan animasi → klik animation → 

pilih animasi yang dipilih → drag animasi ke dalam video yang ada di timeline → atur 

lama animasi. 

1) Klik 2 kali pada gambar atau video yang ingin diberikan animasi → klik animation 

→ pilih animasi yang dipilih →  

 

2) Drag animasi ke dalam video yang ada di timeline → atur lama animasi. 

 

 

  



6. Export Media  

Klik Menu Export → Pilih Create Video → Pilih Format yang diinginkan → beri nama 

pada video → pilih save to untuk dimana file akan disimpan → atur resolusi yang 

dibutuhkan → pilih export → video sudah proses ter-export dan tunggu sampai video 

selesai diexport atau 100% coverting 

a. Klik Menu Export → Pilih Create Video 

 

b. Pilih Format yang diinginkan 

 

c. Beri nama pada video → pilih save to untuk dimana file akan disimpan → atur resolusi 

yang dibutuhkan 

 



d. Klik Export 

 

e. Video sudah proses ter-export dan tunggu samapai video selesai  atau 100% 

coverting 

 

 

 

 

 

  



LEMBAR KERJA 

Nama   : 

NIM  : 

Jenis Tugas : Praktek Individu  

Metode/Cara Pengerjaan Tugas: 

1. Membuat Video berdasarakan story board yang sudah dibuat dan menggunakan teknik 

pengambilan video yang sudah dijelaskan 

2. Video bebas tapi berkaitan dengan kesehatan 

3. Beri nama File : Nama_NIM_P2MK_Praktik Video 

4. Upload di G-Drive kelas P2MK 

 

 

  



Modul 9 : Pembuatan Video Dengan MS. Power Point 

Materi Estimasi Waktu Capaian Pembelajaran 

a. Pembuatan video 

berbasis PPT  

Materi : 70 Menit 

Praktikum : 100 Menit 

a. Mahasiswa mampu 

memahami dan 

mengaplikasikan 

pembuatan animasi 

berbasis PPT 

 

Materi 8 

Dalam pembuatan video dapat menggunakan beberapa cara, salah satunya memanfaatkan 

aplikasi MS. Power Point sebagai salah satu cara untuk membuat video. Dalam pembuatan 

video menggunakan MS. Power Point digunakan Microsoft tahun 2010 ke atas. Berikut 

penjelasan beberapa cara membuat video menggunakan MS. Power Point: 

I. Menggunakan Screen Recording  

Dalam MS. Power Point pada tools record, dapat ditemukan tool Screen Recording, fungsi 

dari tool ini adalah untuk merekam Sebagian atau seluruh layar desktop computer.  

 

 

 

Cara menggunakan screen recording: 

1. Siapkan Materi dalam bentuk Slide PPT di MS. Power Point 

2. Klik Screen Recording pada Record 

 

  



3. Akan muncul menu seperti ini  

 

 

4. Pilih Select Area. Untuk memilih area mana yang ingin direkam  

 

 

5. Lalu aktifkan audio dan record painter (jika dibutuhkan) 

 

6. Klik Record untuk memulai perekaman layar  

 

  



7. Setelah itu, tunggu sampai penghitungan mundur untuk merekam, setelah itu dapat 

melakukan perekaman layar.   

 

 

8. Ketika perekaman ingin diberhentikan sejenak maka arahakan kursor ke atas atau 

tempat tools dari screen recording, lalu klik pause. Jika ingin menuntaskan perekaman 

video klik Stop  

 

  



9. Hasil rekaman layar akan muncul pada slide 1 atau slide dimana dimulai perekaman 

layar, dan langsung berbentuk video di dalam slide tersebut.  

 

 

10. Untuk menyimpannya dapat klik kanan, pilih save media as, pilih lokasi file akan 

disimpan dan klik save.  

 

 



 

 

II. Menggunakan Export to Video  

1. Siapkan Materi dalam bentuk Slide PPT di MS. Power Point 

2. Klik tools record, dapat ditemukan tool Export to Video 

 

3. Lalu muncul halaman seperti ini  

 

 



4. Dalam create video ada beberapa opsi (1) mengatur resolusi, (2) opsi untuk merekam 

suara atau tidak merekam suara (voice over), (3) mengatur durasi perekaman per slide, 

(4) export slide menjadi video. 

 

 

5. Jika sudah selesai untuk mengatur resolusi, sound dan durasi, maka klik Export to Video 

(4), pilih lokasi penyimpanan dan save.  

 

III. Penggunaan tool record  

1. Siapkan Materi dalam bentuk Slide PPT di MS. Power Point 

2. Klik Record pada Menu Record 

 

 

 

3. S etelah itu akan terlihat layar seperti dibawah ini, (1) record: untuk merekam video dan 

audio, (2) untuk memberhentikan rekaman, (3) untuk memutar kembali rekaman, (4) 

tampilan slide, (5) tampilan alat untuk pen tool, eraser dll yang dapat digunakan untuk 

penjabaran atau note tambahan ketika membuat video, sehingga terlihat seperti coretan 

di papan tulis pada saat direkam, (7) audio dan video : untuk mengatur penggunaan 

suara atau video, (7) tampilan ketika menyalakan tombol rekaman video. 

 

1 
2 

3 

4 



 

 

4. Untuk Merekam klik tombol record, maka video atau audio dapat terekam, untuk 

berhenti klik tombol stop.  

5. Hasil rekaman akan muncul pada setiap slide yang sudah direka audio maupun video.  

 

 

  

2

 

1 

3 

4 
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7 



6. Untuk menyimpan dapat menggunakan tool export to video 

 

 

7. Lalu muncul halaman seperti ini  

 

 

8. Jika sudah selesai untuk mengatur resolusi, sound dan durasi, maka klik Export to Video 

(4), pilih lokasi penyimpanan dan save.  

  

 

 



LEMBAR KERJA 

Nama   : 

NIM  : 

Jenis Tugas : Praktek Individu  

Metode/Cara Pengerjaan Tugas: 

Tugas 1 (Membuat PPT dan Membuat Video) 

1. Membuat sebuah video dan PPT berdurasi maksimal 5 menit 

2. Format PPT yang dijadikan video dalam bentuk pdf dan upload di OLU 

3. Beri nama File PPT : Nama_NIM_P2MK_Video PPT 

4. Video mengenai edukasi preventif, kuratif dan rehabilitatif suatu penyakit (penyakitnya 

bebas) 

5. Video Beri nama File Video : Nama_NIM_P2MK_Praktik Video PPT 

6. Upload di G-drive kelas P2MK 

  



Modul 10 : Dasar Desain Grafis  

Materi Estimasi Waktu Capaian Pembelajaran 

Dasar Desain Grafis  
Materi : 60 Menit  

Praktikum : 110 Menit 

Mahasiswa mampu 

memahami dasar desain 

grafis  

 

Materi 10 

Kata desain memiliki arti merancang atau merencanakan. Kata grafis sendiri 

mengandung dua pengertian: (1) graphien (Latin = garis, marka) yang kemudian menjadi 

graphic arts atau komunikasi grafis, (2) graphise vakken (Belanda = pekerjaan cetak) yang di 

Indonesia menjadi grafika, diartikan sebagai percetakan. Jadi, pengertian desain grafis adalah 

pekerjaan dalam bidang komunikasi visual yang berhubungan dengan grafika (cetakan) dan/ 

atau pada bidang dua dimensi, dan statis (tidak bergerak dan bukan time-based image).  

Secara khusus, Desain grafis adalah bentuk komunikasi visual yang 

memanfaatkan elemen grafis, seperti gambar, teks, warna, dan sebagainya untuk 

menyampaikan informasi secara efektif. 

I. Komponen Desain Grafis 

1. Titik/Dot/Verteks 

 Titik sebagai salah satu komponen desain grafis yang paling mendasar, baik berdiri 

sebagai individual maupun sebagai kelompok, komponen titik memberikan nuansa 

komunikasi yang berarti dalam sebuah desain. Potensi titik, antara lain sebagai berikut:  

a. Membentuk sebuah makna: titik tunggal bermakna selesai, titik berkelompok 

bermakna kesatuan atau kebersamaan;  

b. Mengekspresikan nilai statis dan emosi: titik tunggal yang berdiri sebagai 

kemantapan atau bernilai absolut serta berdiri sebagai penekanan selesai;  

c. Dalam desain, bisa berperan sebagai pemberian aksen (sebagai elemen dekoratif, 

elemen emosi, dan elemen bahasa gambar). 

 

 
Gambar 10. 1. Komponen Desain : Titik 



2. Garis/Line 

Garis adalah sebuah komponen desain grafis yang merupakan perapatan 

dari sekelompok titik yang berurut dan berunut, baik berdiri sebagai elemen 

utama maupun bagian dari (aksen) komunikasi.  

Setiap bentuk garis akan menciptakan kesan yang berbeda-beda. Misalnya, garis tebal 

akan menimbulkan kesan yang tegas, sedangkan garis tipis atau lengkung terkesan lebih 

luwes dan dinamis. Garis pada desain berfungsi untuk membuat keteraturan, 

memperjelas poin tertentu, dan dapat diaplikasikan dalam pembuatan bagan atau grafik. 

Potensi garis, antara lain sebagai berikut:  

a. Membentuk garis tepi/kontur sebuah benda;  

b. Mengekspresikan gerak dan emosi (garis horizontal: tenang, mati; garis diagonal: 

labil (tidak stabil); garis zigzag: kehancuran, retak, tidak tenang; garis 

bergelombang: hidup, kelembutan);  

c. Dalam desain, bisa berperan sebagai pemberian aksen (sebagai pembatas, kolom, 

dan dekoratif desain). 

 

 

Gambar 10. 2. Komponen Desain : Garis 

 

3. Bentuk/Raut/Kurva 

Bentuk/raut/kurva adalah sebuah komponen desain grafis yang merupakan 

bertemunya titik awal garis dengan titik akhir garis. Tentunya, hasil dari garis yang 

bertemu ini membentuk sebuah bidang. Bidang merupakan garis yang ujungnya 

saling bertemu dan membuat area tertutup. Bidang tersebut, baik berdiri sebagai 

elemen utama maupun bagian dari (aksen) komunikasi, sangat berperan dalam 

memberikan nuansa komunikasi yang berarti dalam sebuah desain. 



 

a. Bidang Geometris, bidang teratur yang dibuat secara matematis, memiliki sifat 

yang terstruktur dan pasti. Contohnya: lingkaran, segituga, persegi, wajik, dsb. 

 

Gambar 10. 3. Ilustrasi Bentuk-Bentuk Geometris 

 

b. Bidang Non-Geometri, bidang yang dibuat secara bebas. Rupa bidang non 

geometri bisa berbentuk bidang organik (bidang yang dibatasi garis patah-patah 

bebas), bidang bersudut bebas, bidang gabungan antara lengkung dan sudut, 

serta bidang maya (seperti garis maya). 

 

Gambar 10. 4. Ilustrasi Bentuk Non-Geometri 
  



4. Ruang 

Ruang merupakan jarak antara unsur-unsur desain grafis, seperti objek, background, 

dan teks. Tanpa adanya ruang, kita akan sulit untuk mencerna informasi yang ingin 

disampaikan. 

 

Gambar 10. 5. Komponen Desain : Ruang 

Sumber : (Ammariah, 2022) 
 

5. Terang-bayang/highlight dan Shadow 

Cahaya berpengaruh terhadap gelap terang suatu objek, di suatu karya seni gelap 

terang juga dibutuhkan untuk memperdalam kesan seni itu sendiri. Misalnya pada 

lukisan kamar, Pendekatan terang-bayang ini menghasilkan nuansa realistik dan/atau 

fotografik pada sebuah komponen desain. 

 

Gambar 10. 6. Komponen desain: highlight dan Shadow 

 

 



6. Warna/Color 

Warna adalah sensasi yang ditimbulkan oleh otak sebagai akibat daripada sentuhan 

gelombang-gelombang cahaya pada retina mata. Warna pada dasar keilmuan desain 

grafis mengacu pada lingkaran warna pigmen (subtractive), yang membagi warna 

dasar/primer menjadi merah, kuning, dan biru (RGB), kemudian masuk dalam turunan 

pertama/sekunder, dan seterusnya. Sementara dalam pekerjaan yang berhubungan 

dengan layar (animasi, televisi, web design) mengacu pada lingkaran warna cahaya 

(additive). 

 

Gambar 10. 7. Warna Pigmen (Subtractive) dan Warna Cahaya (Additive) 
Sumber : (Sari, 2021) 

 

Potensi warna dalam desain grafis antara lain sebagai berikut.  

a. Warna serta nilai gelap dan terangnya, dapat dimanfaatkan untuk memberikan 

kesan  berat-ringan benda, volume, kedalaman komposisi, dan sebagainya.  

b. Warna menciptakan suasana/mood//sifat/karakter tertentu pada rancangan. 

 

Gambar 10. 8. The Psychology of Color 
Sumber : (Olesen, 2022) 



7. Tekstur 

Tekstur merupakan visualisasi dari permukaan suatu objek yang dapat dinilai dengan 

cara dilihat atau diraba. Contohnya, corak dari suatu permukaan benda. Ada yang halus, 

kasar, lembut, licin, berpori, mengkilap, dan sebagainya. Penggunaan tekstur dapat 

menambah dimensi dan memperkaya sebuah layout, sehingga objek jadi lebih hidup. 

Selain itu, tekstur juga bisa membawa audiens supaya lebih mendapatkan feel (rasa) 

atau emosi tertentu dalam sebuah desain.  

Tekstur merupakan salah satu unsur seni yang unik karena ia dapat mengaktifkan 2 

proses penginderaan sekaligus (visual dan raba). Tekstur dapat berukuran kecil, 

menekankan pada kedua-dimensian permukaan sebagai hiasan, atau berukuran besar 

yang menekankan pada kesan raba pada 3D. Potensi tekstur, antara lain sebagai 

berikut: 

a. Memperkaya kenikmatan visual; 

b. Dipakai dalam memvisualkan objek; 

c. Membangkitkan perasaan untuk meraba; 

d. Memperjelas kesan adanya ruang; 

e. Tekstur dan kesan ruang: tekstur detail/halus (jarak dekat) dan tekstur blur/kurang 

jelas (jarak jauh). 

 

 

Gambar 10. 9. Komponen Desain : Tekstur 
Sumber : (portaldekave.com, 2022) 

 

II. Mengaplikasikan Prinsip Dasar Desain Grafis 

1. Keseimbangan (Balance) 

Keseimbangan dapat dicapai dengan menampilkan unsur-unsur desain, seperti bentuk 

dan ukuran, warna, tekstur, dan sebagainya agar unsur-unsur yang ada dikomposisikan 



dengan serasi, sepadan, dan memberi kesan mantap serta tepat pada tempatnya. 

Dengan menerapkan prinsip keseimbangan, desain yang kita buat akan memiliki estetika 

yang baik dan lebih komunikatif.  

Secara garis besar, sifat keseimbangan dibagi 2 macam, yaitu: 

a. Keseimbangan Nyata (Formal Balance) 

b. Keseimbangan Tak Nyata (Informal Balance) 

 

Bentuk keseimbangan terbagi 2 macam : 

a. Simetris/Symmetric (Berkesan Statis) 

Pada umumnya, yang terjadi bersifat formal balance, tetapi bisa juga informal 

balance. Keseimbangan simetris terbagi dalam 2 macam, yaitu axial balance 

(berdasar garis sumbu), bentuk yang sama (posisi, letak, ukuran, warna, dan lain-

lain) dalam 2 ruang (kiri-kanan, atas bawah sebagai garis sumbu), dan radial balance 

(berdasarkan titik sumbu). Keseimbangan bisa terjadi, baik secara fisik maupun 

secara optis. Untuk menghayatinya hanya diperlukan satu titik atau sumbu khayal, 

guna menentukan letak objek yang akan disusun menurut prinsip keseimbangan. 

 

 

Gambar 10. 10. Simetris dan Asimetris 

Sumber : (Grafis Media, 2017) 
 

b. Asimetris/asymmetric (Berkesan Dinamis) 

Memiliki sifat informal balance, karena bagian-bagiannya (entah itu posisinya, 

letaknya, ukurannya, warnanya, atau lainnya) dirancang variatif untuk pencapaian 

kedinamisan,. namun, memiliki kesan sama berat/seimbang. Hal ini merupakan 

upaya menciptakan penekanan dalam sebuah tampilan visual. Penekanan ini 

dilakukan untuk mengurangi unsur kejenuhan visual yang tampil dari sudut visual 



yang simetris. Pola asimetris ini pada hakikatnya juga menyentuh upaya aplikasi 

golden ratio dalam meningkatkan unsur estetika. 

 

 

Gambar 10. 11. Ilustrasi untuk keseimbangan Axial dan Radial 
 

2. Kesatuan (Unity) 

Kesatuan (unity) dalam desain grafis berarti kohesi, konsistensi, keutuhan, dan 

keselarasan semua unsur desain. Dengan memperhatikan prinsip kesatuan, karya yang 

dibuat bisa lebih padu dan menghasilkan tema yang kuat. Contohnya, saat memilih tone 

warna pada desain, bisa menggunakan color palette supaya tidak ada warna yang saling 

bertabrakan. Selain itu, juga bisa menggunakan jenis font yang sama atau setipe jika 

desain yang digunakan banyak mengandung teks. 

 

3. Ritme (Rhythm) 

Irama dalam desain grafis adalah pengulangan atau variasi pada unsur-unsur desain. 

Irama bisa dihasilkan dari pengulangan unsur-unsur yang sama dengan cara yang 

konsisten, atau unsur-unsur yang berbeda (dari segi bentuk, ukuran, posisi, atau unsur) 

tapi membentuk pola berirama. Secara psikologi, mata manusia akan mengarah dari 

unsur warna yang gelap ke terang, dan/atau dari area yang kompleks ke area yang 

sederhana (simple). 

 



 

Gambar 10. 12. Repetition, Pattern dan Rhythm 

Sumber : (vriske.com, 2016) 
 

Repetition adalah pengulangan yang terjadi namun dalam interval tertentu. 

Pattern adalah elemen-elemen yang dibentuk dan diulang dalam suatu susunan 

yang teratur dan sama. 

Rythm adalah kombinasi dari unsur-unsur yang diulang yang mengalami variasi 

namun masih sinergis. 

 

4. Penekanan (Emphasis) 

Penekanan adalah cara untuk menentukan bagian mana yang menjadi prioritas dalam 

desain yang dibuat. Biasanya, bagian ini merupakan informasi atau kesan yang ingin 

kita sampaikan ke audiens. enis penekanan dalam desain grafis ada 3, yaitu: 

a. Hierarki, yaitu ditentukan berdasarkan urutan atau susunan. 

b. Skala dan proporsi, yaitu menonjolkan informasi utama dengan ukuran font yang 

lebih besar atau memakan space desain yang lebih banyak. 

c. Kontras, yaitu menempatkan dua unsur desain yang saling bertentangan satu 

dengan yang lainnya dalam satu frame desain. 

 



 

Gambar 10. 13. Penekanan Kontras 

Sumber : (Lile, 2022) 
 

5. Proporsi (Proportion) 

Pada dasarnya, proporsi adalah perbandingan matematis dalam sebuah bidang. 

Proporsi merupakan perbandingan antara bentuk elemen besar dengan elemen kecil. 

Proporsi menyangkut hubungan antara satu bagian dengan bagian yang lain atau bagian 

dengan keseluruhan, atau antara satu obyek dan obyek yang lainnya.  

Proporsi yang tidak tepat, akan membuat sebuah desain menjadi tidak enak 

dipandang. Semua unsur yang terdapat pada sebuah karya desain, harus ditata proporsi 

setiap unsurnya sedemikian rupa, mulai dari garis, bidang, bentuk, warna dan 

seterusnya. 

 

Gambar 10. 14. Proporsi 
Sumber : (Ismail, 2022) 

  



LEMBAR KERJA 

Nama   : 

NIM  : 
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Metode/Cara Pengerjaan Tugas: 

1. Memahami prinsip desain grafis sesuai dengan contoh yang diberikan serta 

pengaplikasiannya dalam desain grafis  

  



Modul 11 : Pengenalan Tools Photoshop 

Materi Estimasi Waktu Capaian Pembelajaran 

Dasar Desain Grafis dan 

Pengenalan Tools Adobe 

Photoshop 

Materi : 60 Menit  

Praktikum : 110 Menit 

Mahasiswa mampu 

memahami dasar dan 

fasilitas yang ada di dalam 

Adobe Photoshop 

 

MATERI 11  

I. Interface dari Adobe Photoshop 2018 

 

Menu Bar : Menu bar adalah menu pulldown yang memberikan perintah-perintah 

dalam Program Photoshop diantarannya adalah menu File, Edit, gambar, 

Layer, Select, Filter, View, Window, dan Help. Baris menu ini dikelompokan 

berdasarkan topiknya 

Toolbox : Toolbox yaitu, palet-palet yang berisi tombol perintah,seperti  tombol 

perintah untuk menyeleksi, memotong (crooping), menyunting, menulis 

teks, membuat bentuk (shape), dan lainnya. 

Option Bar : Merupakan bagian yang berisi perintah tambahan yang isinya akan selalu 

berubah bergantung pada tombol perintah yang di pilih pada bagian 

Toolbox. Contoh seperti kita menggunakan kuas (brushes) di situ kita dapet 

mengatur besaran kuas tersebut di dalam Options Bar, begitu juga perintah 

Toolbox 

Option Bar 

Menu Bar 

Zoom Level 

Status Bar 

Workspace

e 

Panel 



Toolbox yang lainnya yang akan di gunakan,di pastikan kita dapat 

mengatur di Options bar. 

Workspace : Workspace atau area kerja yang terletak di paling tengah ini yaitu, lembar 

kerja atau file utama yang berisikan gambar,objek,teks,lukisan,foto yang 

akan kita olah di dalam photoshop. 

Panel : Panel, yaitu terdiri dari beberapa palet editor  yang di dalamnya terdapat 

beberapa perintah untuk manipulasi dokumen,seperti penggunaan 

layer,pengaturan layer,adjustments,masking,dan banyak lagi. 

Zoom Level : Tingkat pembesaran saat ini ditampilkan, Anda dapat mengetikkan 

persentase yang berbeda di bidang tersebut untuk mengubah tingkat 

pembesaran. 

Status Bar : Bilah Status menampilkan lebih banyak info tentang gambar saat Anda 

mengeklik dan menahannya. Anda juga dapat mengubah jenis informasi 

yang ditampilkan Bilah Status. Klik panah di sebelah kanan Bilah Status 

untuk membuka menu tempat Anda dapat memilih untuk melihat detail 

yang berbeda, seperti Ukuran Dokumen (ukuran file) atau Dimensi (lebar, 

tinggi, dan resolusi) 

 

II. Membuat dan Memodifikasi Lembar Kerja/Kanvas 

Untuk membuat dokumen baru atau membuka file di komputer Anda, klik "File" di menu 

kiri atas. Pilih "New" untuk membuat dokumen baru. Atau klik "Open" untuk membuka 

komputer Anda dan membuka file yang ada. 

Saat Anda membuat dokumen baru, kotak dialog akan muncul. Pada kotak dialog 

tersebut, Anda dapat memberi nama file dan memilih ukuran dan resolusi yang Anda 

inginkan. Hal Ini berguna apabila website Anda memerlukan ukuran file tertentu untuk agar 

foto tampil optimal dan tidak memberatkan perfoma website. 



 

1. Preset Sizes : Untuk menentukan ukuran lembar kanvas. 

2. Width : Untuk meneNtukan lebar image.  

3. Height : Untuk menentukan tinggi image 

4. Resolution : Untuk menentukan resolusi yang diinginkan. 

5. Mode : Bentuk pilihan warna.  

a. RGB (Red, Green, Blue) Color yang masing-masing mempunyai jumlah warna 256.  

b. CMYK (Cyan, Magenta, Yellow, blacK) Color yang terdiri dari 4 warna, 32 bit per 

pixel. Gunakan mode ini jika gambar ingin dicetak berwarna.  

c. Bitmap adalah gambar yang terdiri dari 1 bit warna (hitam dan putih)atau disebut 

juga dengan gambar 1-bit dan memiliki ukuran paling kecil.  

d. Lab (Lightness, a = dari green ke red, b = dari blue ke yellow) adalah gambar 

yang menggunkan 3 komponen untuk mewakili warna. Anda dapat menggunkan 

mode ini untuk bekerja dengangambar-gambar Photo CD. Sedangkan Lab Color 

adalah warna internal yang digunakan Photoshop ketika mengkonversi mode 

warna yang satu ke yang lain.  

e. Grayscale adalah gambar yang hanya akan bewarna hitam putih. 

6. Background Content, untuk menentukan warna dasar kanvas. 

 

 

 



III. Pengenalan Tools di Photoshop 

 

 

 

Tanda bintang (*) setelah nama tools menunjukkan default tools, dan huruf dalam 

kurung adalah shortcut keyboard untuk mengakses tools secara cepat. Untuk 

menelusuri tools dengan shortcut keyboard yang sama, Pins bisa tekan dan tahan Shift saat 

ketika menekan huruf tersebut. 

 

  



1. Move and Selection Tools 

Ikon 

Tools 
Nama Tools dan Fungsi 

 

Move Tool * ( V ) 

 

Move Tool digunakan untuk memindahkan layer, seleksi, dan panduan dalam 

dokumen Photoshop. Bisa juga mengaktifkan “Auto-Select” secara otomatis 

saat memilih lapisan atau objek gambar yang dipilih. 

 

Artboard Tool ( V ) 

 

Artboard Tool memungkinkan kamu mendesain beberapa web atau UX (user 

experience) dengan mudah untuk berbagai perangkat atau ukuran layar. 

 

Rectangular Marquee Tool * ( M ) 

 

Rectangular Marquee Tool menarik garis seleksi persegi panjang. Tekan dan 

tahan Shift saat kamu menyeret untuk menggambar pilihan persegi. 

 

Elliptical Marquee Tool ( M ) 

 

Elliptical Marquee Tool menarik garis seleksi elips. Tekan dan tahan Shift untuk 

menggambar pilihan dalam lingkaran sempurna. 

 

Single Row Marquee Tool 

 

Single Row Marquee Tool di Photoshop akan memilih satu baris piksel pada 

gambar dari kiri ke kanan. 

 

Single Column Marquee Tool 

 

Single Column Marquee Tool untuk memilih satu kolom piksel dari atas ke 

bawah. 



Ikon 

Tools 
Nama Tools dan Fungsi 

 

Lasso Tool * ( L ) 

 

Lasso Tool dapat dipakai untuk menggambar garis seleksi bentuk bebas di 

sekitar objek. 

 

Polygonal Lasso Tool ( L ) 

 

Klik di sekitar objek dengan Polygonal Lasso Tool untuk mengelilinginya dengan 

garis seleksi poligonal bermata lurus. 

 

Magnetic Lasso Tool ( L ) 

 

Lasso Tool Magnetic untuk mengunci garis seleksi ke tepi objek saat kamu 

memindahkan kursor di sekitarnya. 

 

Object Selection Tool * ( W ) 

 

Object Selection Tool memungkinkan kamu untuk memilih salah satu objek 

hanya dengan menyeret garis di sekitar objek. 

 

Quick Selection Tool ( W ) 

 

Quick Selection Tool memungkinkan kamu memilih salah satu objek 

dengan brush. Bisa juga aktifkan “Auto-Enhance” di Options Bar untuk pilihan 

kualitas yang lebih baik. 

 

Magic Wand Tool ( W ) 

 

Magic Wand Tool Photoshop berfungsi untuk memilih area dengan warna yang 

sama dengan satu kali klik. 

 



2. Crop & Slice Tools 

Ikon 

Tools 
Nama Tools dan Fungsi 

 

Crop Tool * ( C ) 

 

Crop Tool di Photoshop berfungsi untuk memotong gambar dan menghapus 

area yang tidak diinginkan. Pins bisa menghapus centang dengan klik “Delete 

Cropped Pixels” di Option Bar untuk memotong tanpa merusak gambar. 

 

Perspective Crop Tool ( C ) 

 

Perspective Crop Tool merupakan tools di Photoshop untuk memotong 

gambar dan memperbaiki distorsi umum atau masalah perspektif. 

 

Slice Tool ( C ) 

 

Slice Tool untuk membagi gambar atau layout menjadi bagian yang lebih kecil 

(irisan) yang dapat diekspor dan dioptimalkan secara terpisah. 

 

Slice Select Tool ( C ) 

 

Slice Select Tool merupakan tools di Photoshop untuk memilih irisan objek 

yang dibuat dengan Slice Tool. 

 

Frame Tool * ( K ) 

 

Frame Tool memungkinkan kamu menempatkan gambar ke dalam bentuk 

persegi panjang atau elips. 

 

  



3. Measurement Tools 

Ikon 

Tools 
Nama Tools dan Fungsi 

 

Eyedropper Tool * ( I ) 

 

Eyedropper Tool Photoshop berfungsi untuk mengambil sampel warna dalam 

sebuah gambar. Tingkatkan “Ukuran Sampel” di Options Bar untuk 

representasi warna area sampel yang lebih baik. 

 

3D Material Eyedropper Tool ( I ) 

 

3D Material Eyedropper Tool merupakan tools di Photoshop untuk mengambil 

sampel bahan dari model 3D di Photoshop. 

 

Color Sampler Tool ( I ) 

 

Color Sampler Tool menampilkan nilai warna untuk area yang dipilih dalam 

gambar. 

 

Ruler Tool ( I ) 

 

Ruler Tool berfgunsi untuk mengukur jarak, lokasi, dan sudut. Biasa digunakan 

untuk memposisikan gambar dan elemen agar bisa tepat pada posisi yang 

diinginkan. 

 

Note Tool ( I ) 

 

Note Tool memungkinkan kamu untuk melampirkan catatan berbasis teks ke 

dokumen Photoshop, baik untuk diri sendiri atau orang lain yang mengerjakan 

proyek yang sama. Catatan akan disimpan dalam bentuk format file PSD. 



Ikon 

Tools 
Nama Tools dan Fungsi 

 

Count Tool ( I ) 

 

Count Tool untuk menghitung secara manual jumlah objek dalam gambar, 

atau agar Photoshop secara otomatis menghitung beberapa area yang dipilih 

dalam gambar. 

 

4. Retouching dan Painting tools 

Ikon 

Tools 
Nama Tools dan Fungsi 

 

Spot Healing Brush Tool * ( J ) 

 

Spot Healing Brush di Photoshop berfungsi untuk menghilangkan noda dan 

daerah kecil lainnya dalam sebuah gambar. Gunakan ukuran kuas sedikit lebih 

besar dari noda untuk hasil terbaik. 

 

Healing Brush Tool ( J ) 

 

Healing Brush memungkinkan kamu memperbaiki masalah daerah yang lebih 

besar dalam sebuah gambar dengan proses mengecat. Tahan Alt (Windows) 

/ Option (Mac) dan klik untuk mengambil sampel tekstur yang baik, lalu cat 

pada daerah yang diinginkan. 

 

Patch Tool ( J ) 

 

Dengan Patch Tool berfungsi untuk membuat garis seleksi di sekitar area yang 

bermasalah. Kemudian perbaiki dengan menyeret garis seleksi di atas area 

dengan tekstur yang lebih baik. 



Ikon 

Tools 
Nama Tools dan Fungsi 

 

Content-Aware Move Tool ( J ) 

 

Content-Aware Move Tool digunakan untuk memilih dan memindahkan bagian 

dari gambar ke area yang berbeda. Photoshop secara otomatis mengisi lubang 

di tempat asli menggunakan elemen dari area sekitarnya. 

 

Red Eye Tool ( J ) 

 

Red Eye Tool menghilangkan masalah mata merah yang umum pada foto yang 

dihasilkan dari lampu kilat kamera. 

 

Brush Tool * ( B ) 

 

Brush Tool adalah alat lukisan utama Photoshop. Bisa digunakan untuk 

melukis sapuan kuas pada layer atau pada layer mask. 

 

Pencil Tool ( B ) 

 

Pencil Tool adalah alat melukis Photoshop seperi pensil biasa digunakan untuk 

menggambar objek dengan hasil yang halus. 

 

Color Replacement Tool ( B ) 

 

Color Replacement Tool di Photoshop untuk mengganti warna objek dengan 

warna yang berbeda dengan mudah. 

 

Mixer Brush Tool ( B ) 

 

Mixer Brush di Photoshop dapat mensimulasikan elemen lukisan nyata seperti 

mencampur dan menggabungkan warna. 



Ikon 

Tools 
Nama Tools dan Fungsi 

 

Clone Stamp Tool * ( S ) 

 

Clone Stamp Tool adalah fitur yang paling dasar dari retouching tool di 

Photoshop untuk membuat manipulasi objek dan menduplikasikannya ke 

gambar tujuan. 

 

Pattern Stamp Tool ( S ) 

 

Pattern Stamp Tool untuk melukis pola di atas gambar. 

 

History Brush Tool * ( Y ) 

 

History Brush Tool untuk melukis gambar atau foto Pins sebelumnya. 

 

Art History Brush Tool ( Y ) 

 

Art History Brush juga melukis berbagai foto untuk melukis dengan berbagai 

macam efek kuas. 

 

Eraser Tool * ( E ) 

 

Eraser Tool di Photoshop secara permanen akan menghapus piksel pada layer, 

juga dapat digunakan untuk melukis gambar atau objek Pins sebelumnya. 

 

Background Eraser Tool ( E ) 

 

Background Eraser Tool berfungsi untuk menghapus area warna yang sama 

dalam sebuah gambar dengan mengecat atas mereka. 

 

Magic Eraser Tool ( E ) 

 

Magic Wand Tool berfungsi untuk menghapus bagian tertentu pada objek 

secara permanen. 



Ikon 

Tools 
Nama Tools dan Fungsi 

 

Gradient Tool * ( G ) 

 

Gradient Tool Photoshop berfungsi untuk memberikan campuran beberapa 

warna berbeda pada objek. 

 

Paint Bucket Tool ( G ) 

 

Paint Bucket Tool berguna untuk mengisi area dengan warna yang sama 

dengan warna Foreground atau pola yang kamu buat. 

 

3D Material Drop Tool ( G ) 

 

Digunakan dalam pemodelan 3D, tool memungkinkan kamu mengambil 

sampel bahan dari satu area dan memindahkannya ke area lain dari 

model, mesh atau 3D layer. 

 

Blur Tool * 

 

Blur Tool berfungsi untuk mengaburkan dan menghaluskan area pada objek 

atau gambar. 

 

Sharpen Tool 

 

Sharpen Tool berguna untuk mempertajam area yang kamu cat. 

 

Smudge Tool 

 

Smudge Tool di Photoshop berfungsi untuk mencoreng area yang diwarnai. Ini 

juga dapat digunakan untuk membuat efek lukisan jari. 



Ikon 

Tools 
Nama Tools dan Fungsi 

 

Dodge Tool * ( O ) 

 

Dodge Tool digunakan untuk melukis area tertentu pada gambar dan 

mencerahkannya. 

 

Burn Tool ( O ) 

 

Burn Tool berfungsi untuk menggelapkan area yang akan dicat. 

 

Sponge Tool ( O ) 

 

Sponge Tool untuk menambahkan atau mengurangi saturasi warna gambar. 

 

5. Drawing dan Type Tools 

Ikon 

Tools 
Nama Tools dan Fungsi 

 

Pen Tool * ( P ) 

 

Pen Tool Photoshop memungkinkan kamu menggambar path, bentuk vektor, 

atau pilihan yang sangat presisi. 

 

Freeform Pen Tool ( P ) 

 

Freeform Pen Tool merupakan tools di Photoshop yang memungkinkan kamu 

menggambar path atau bentuk dengan tangan bebas. 



Ikon 

Tools 
Nama Tools dan Fungsi 

 

Curvature Pen Tool ( P ) 

 

Curvature Pen Tool adalah versi sederhana dari Pen Tool. Baru tersedia pada 

Photoshop CC 2018. 

 

Add Anchor Point Tool 

 

Add Anchor Point Tool merupakan tools di Photoshop untuk 

menambahkan anchor point tambahan di sepanjang path. 

 

Delete Anchor Point Tool 

 

Delete Anchor Point Tool untuk menghapus titik sepanjang path yang dibuat. 

 

Convert Point Tool 

 

Pada sebuah path, Convert Point Tool berfungsi untuk mengubahnya menjadi 

titik sudut. 

 

Horizontal Type Tool * ( T ) 

 

Horizontal Type Tool di Photoshop digunakan untuk menambahkan tulisan 

atau text dari kiri ke kanan. 

 

Vertical Type Tool ( T ) 

 

Vertical Type Tool untuk menabahkan text dari atas ke bawah. 

 

Vertical Type Mask Tool ( T ) 

 

Vertical Type Mask Tool berfungsi untuk memberi seleksi berbentuk teks 

secara vertikal 

. 



Ikon 

Tools 
Nama Tools dan Fungsi 

 

Horizontal Type Mask Tool ( T ) 

 

Horizontal Type Mask Tool berfungsi untuk memberikan seleksi berbentuk 

teks secara horizontal. 

 

Path Selection Tool * ( A ) 

 

Gunakan Path Selection Tool (panah hitam) di Photoshop untuk memilih dan 

memindahkan seluruh path sekaligus. 

 

Direct Selection Tool ( A ) 

 

Direct Selection Tool (panah putih) untuk memilih dan memindahkan 

segmen path individual, titik jangkar, atau arah. 

 

Rectangle Tool * ( U ) 

 

Rectangle Tool menarik bentuk vektor persegi panjang, path atau bentuk 

piksel. 

 

Rounded Rectangle Tool ( U ) 

 

Rounded Rectangle Tool mirip dengan Rectangle Tool tapi menarik bentuk 

dengan sudut membulat. 

 

Ellipse Tool ( U ) 

 

Ellipse Tool berfungsi untuk menarik bentuk vektor elips, path atau 

bentuk pixel. 



Ikon 

Tools 
Nama Tools dan Fungsi 

 

Triangle Tool ( U ) 

 

Triangle Tool untuk menggambar bentuk segitiga. Tahan Shift untuk 

menggambar segitiga sama sisi atau gunakan opsi Radius untuk membulatkan 

sudut. 

 

Polygon Tool ( U ) 

 

Polygon Tool digunakan untuk menarik bentuk poligonal. Gunakan opsi Star 

Ratio untuk mengubah poligon menjadi bintang. 

 

Line Tool ( U ) 

 

Line Tool untuk menarik garis lurus atau panah. Gunakan warna dan bobot 

Stroke untuk mengontrol tampilan garis. 

 

Custom Shape Tool ( U ) 

 

Memungkinkan kamu dalam memilih dan menggambar dalam bentuk khusus. 

 

6. Navigation Tools Photoshop 

Ikon 

Tools 
Nama Tools dan Fungsi 

 

Hand Tool * ( H ) 

 

Memungkinkan kamu untuk mengklik dan drag gambar di sekitar di layar 

untuk melihat daerah yang berbeda ketika diperbesar. 



Ikon 

Tools 
Nama Tools dan Fungsi 

 

Rotate View Tool ( R ) 

 

Rotate View Tool merupakan tools di Photoshop untuk memutar kanvas 

sehingga kamu dapat melihat dan mengedit gambar dari berbagai sudut. 

 

Zoom Tool * ( Z ) 

 

Zoom Tool merupakan tools di Photoshop untuk memperbesar area 

tertentu. Tekan dan tahan Alt (Win) / Option (Mac) dan klik dengan Zoom 

Tool untuk memperkecil. 

 

  



LEMBAR KERJA 

Nama   : 

NIM  : 

Jenis Tugas : Praktek Individu  

Metode/Cara Pengerjaan Tugas: 

1. Mempraktikkan cara penginstalan Adobe Phptoshop 

2. Menyebutkan nama bagian – bagian Tools dari Adobe Photoshop dan fungsinya  

 

 

  



MODUL 12 : Dasar Tipografi 

Materi Estimasi Waktu Capaian Pembelajaran 

Dasar Tipografi 
Materi : 60 Menit  

Praktikum : 110 Menit 

Mahasiswa mampu 

memahami dasar tipografi 

 

Materi 12 

I. Pengertian Tipografi 

Tipografi (Typography) berasal dari kata Yunani typos = bentuk grapho = menulis Secara 

umum tipografi adalah seni memilih dan menata huruf dengan pengaturan penyebarannya 

pada ruang-ruang yang tersedia, untuk menciptakan kesan khusus, sehingga akan 

menolong pembaca untuk mendapatkan kenyamanan membaca semaksimal mungkin. 

1. TYPEFACE  

Desain dari satu set bentuk huruf, angka, tanda baca yang memiliki satu sifat visual 

yang standar dan konsisten. Sifat tersebut membentuk karakter yang tetap meski rupa 

dan bentuk dimodifikasi. 

2. TYPEFONT  

Satu set bentuk huruf, angka, tanda baca dalam rupa, ukuran dan gaya khusus untuk 

komunikasi.  

3. TYPESTYLE  

Modifikasi typeface yang didesain dari berbagai variasi guna memunculkan karakter 

visual, yang meliputi : weight (light, medium, bold), angle (roman, italic), elaboration 

(outline, shaded, decorated). 

 

Gambar 12. 1. Perbedaan Typeface dan Font 
 

  



II. Klasifikasi Tipografi 

1. Serif 

Serif adalah kelompok jenis huruf yang memiliki “tangkai” (stem). Serif sering 

digunakan untuk potongan teks yang lebih panjang seperti body copy. Kesan yang 

ditimbulkan adalah klasik, anggun, lemah gemulai dan feminin. 

Contoh: Times New Roman, Garamond, BookAntiqua, Bitstream Vera Serif, Palatino 

Linotype, Bookman Old Style, CalistoMT, Dutch, Euro Roman, Georgia, Pan Roman, 

Romantic, Souevenir, Super French dan lain-lain. 

Kegunaan Tangkai Serif 

Pada ukuran teks kecil, seperti seukuran tulisan teks di surat kabar atau buku, 

umumnya tangkai pada kaki-kaki font serif membantu agar tulisan mudah dibaca. 

Karena tangkai font serif membantu membentuk garis tak tampak yang memandu 

pembaca mengikuti sebuah baris teks. Karena itulah kita banyak menjumpai buku-buku 

di layout dengan serif. Menurut penelitian, seseorang yang membaca font serif bisa lebih 

tahan membaca karena tidak mudah lelah akibat adanya bantuan dari tangkai serif.  

Serif tidak digunakan pada kondisi-kondisi berikut ini:  

a. Huruf amat kecil (seperti tulisan bahan-bahan di label makanan);  

b. Huruf amat besar (seperti di plang-plang merek) yang harus dilihat dari jauh;  

c. Di layar monitor; huruf sans serif kadang lebih mudah dibaca. Karena justru kaki-kaki 

font serif memperumit bentuk huruf sehingga sedikit lebih lama dibaca. Jika huruf 

kecil sekali atau pada resolusi rendah seperti di layar monitor, kaki serif bisa tampak 

bertindihan dan menghalangi pandangan. Karenanya kita banyak melihat plang 

rambu lalu lintas menggunakan huruf yang sederhana mungkin agar bisa cepat 

dibaca, dan di halaman web banyak dipakai font serif karena lebih mudah dibaca 

pada ukuran kecil/layar kasar. 

 

Gambar 12. 2. Klasifikasi Tipografi : Serif 
 

  



2. Sans Serif 

Sans serif (atau “tanpa” serif) adalah jenis huruf yang sebaliknya: tidak memiliki 

tangkai. Ujung-ujung kakinya polos begitu saja. Kesan yang ditimbulkan oleh huruf jenis 

ini adalah modern, kontemporer dan efisien. 

Contoh: Arial, Futura, Avant Garde, Bitstream Vera Sans, Century Gothic dan lain 

sebagainya. 

 

Gambar 12. 3. Klasifikasi Tipografi : Sans Serif 
 

3. Script 

Huruf Script menyerupai goresan tangan yang dikerjakan dengan pena, kuas atau 

pensil tajam dan biasanya miring ke kanan. Kesan yang ditimbulkannya adalah sifat 

pribadi dan akrab. 

 

Gambar 12. 4. Klasifikasi Tipografi : Script 
 

4. Dekoratif 

Huruf jenis ini merupakan pengembangan dari bentuk-bentuk yang sudah ada. 

Ditambah hiasan dan ornamen, atau garis-garis dekoratif. Kesan yang dimiliki adalah 

dekoratif dan ornamental. 

 

Gambar 12. 5. Klasifikasi Tipografi : Dekoratif 
 



III. Anatomi Huruf 

Menurut  Sihombing  (2001:12-18)  bahwa  langkah  awal  untuk  mempelajari  tipografi  

adalah mengenali  atau  memahami  anatomi  huruf.  Seperti  halnya  tubuh  manusia,  

huruf  memiliki berbagai  organ  yang  berbeda.  Gabungan  seluruh  komponen  dari  suatu  

huruf  merupakan identifikasi  visual  yang  dapat  membedakan  antara  huruf  yang  satu  

dengan  huruf  yang  lain. Apabila  kita  telah  memahami  anatomi  huruf  secara  baik,  

dengan  mudah  kita  dapat  mengenal sifat  dan  karakteristik  dari  setiap  jenis  huruf.  

Berikut  ini  adalah  terminology yang umum digunakan dalam penamaan setiap komponen 

visual yang terstruktur dalam fisik huruf. 

 

Gambar 12. 6. Anatomi huruf 
 

1. Baseline  

Sebuah  garis  maya  lurus  horizontal  yang  menjadi  batas  dari  bagian  terbawah  

dari setiap huruf besar. 

2. Capline  

Sebuah  garis  maya  lurus  horizontal  yang  menjadi  batas  dari  bagian  teratas  dari  

setiap huruf besar. 

3. Meanline  

Sebuah garis maya lurus horizontal yang menjadi batas dari bagian teratas dari badan 

setiap huruf kecil. 

4. X-Height  

Jarak  ketinggian  dari  baseline  sampai  ke  meanline.  X-height  merupakan  tinggi  dari 

badan huruf kecil. Cara yang termudah mengukur ketinggian badan huruf kecil adalah 

dengan menggunakan huruf „x‟. 

5. Ascender  

Bagian dari huruf kecil yang posisinya tepat berada di antara meanline dan capline.  

6. Descender  

Bagian dari huruf kecil yang posisinya tepat berada di bawah baseline.  



 

IV. Fungsi Tipografi 

Ada beberapa fungsi yang dihasilkan dari pembuatan seni tipografi, fungsi-fungsi itu 

antara lain:  

1. Mudah Dibaca 

Mudah dibaca adalah salah satu fungsi utama dari tipografi. Jadi, tipografi dibuat 

supaya pembaca dapat dengan mudah memahami teks yang dituliskan. Di sini, 

pemilihan font, ukuran, dan warna akan sangat menentukan.  

2. Menarik Perhatian 

Selain untuk memberikan kemudahan, tipografi juga berfungsi untuk menarik 

perhatian para pembaca. Tipografi ini bahkan lebih penting ketimbang ilustrasi dari 

suatu desain publikasi.  

3. Memperkuat Tema Visual 

Tipografi juga menentukan kesan visual di dalam suatu desain grafis. Misalnya ketika 

ingin membuat poster yang bertemakan misteri. Pemilihan font dan warna pun juga 

harus menyesuaikan dengan desain yang ada, agar kesan horor semakin kuat.  

Namun berbeda ketika kita sedang membuat poster yang bertemakan horor, tetapi 

menggunakan warna font yang cenderung berwarna, tentunya akan menghilangkan 

kesan horor.  

4. Memperkuat Karakter 

Memperkuat karakter juga merupakan salah satu fungsi dari tipografi, terutama untuk 

pembuatan desain produk. Pemilihan jenis dan warna tipografi akan sangat menentukan 

karakter dari produknya. 

 

V. Prinsip Tipografi 

1. Readability 

Readability merupakan tingkatan ukuran seberapa mudah teks dapat dibaca. 

Readability ini dipengaruhi oleh beberapa faktor seperti kombinasi dan jarak setiap 

huruf.  

2. Legibility 

Legibility adalah kemudahan dalam mengenali dan membedakan setiap huruf atau 

karakter. Prinsip ini wajib dimiliki oleh setiap huruf untuk menghindari dan memperkecil 

peluang dalam kesalahan mengenali huruf. Jika sebuah tipografi tidak memenuhi prinsip 

legibility, pembaca akan sangat sulit dalam mengenali dan membaca karya tersebut. 



3. Visibility 

Visibility maksudnya adalah tipografi dapat terlihat dalam jarak tertentu. Artinya, 

tipografi disarankan untuk jangan terlalu kecil supaya dapat terlihat oleh para pembaca 

sejauh apapun jarak penglihatannya. Selain itu, jenis font juga akan menentukan 

visibility, karena dalam beberapa kasus, memang tipografi terlihat dengan jelas, tetapi 

tidak bisa terbaca.  

4. Estetika 

Tipografi juga harus memenuhi prinsip estetika. Estetika ini akan sangat 

mempengaruhi keindahan dari tipografi sehingga dapat menarik perhatian orang. 

Semakin bagus tipografi dibuat, maka akan semakin membuat orang penasaran pula. 

 

VI. Jenis Format Font  

Berdasarkan format digitalnya terdapat 4 jenis font digital, yaitu:  

1. Bitmap Font  

2. Poscript Font (Adobe Font)  

3. True Type Font (Apple Font) 

4. Open Type Font (Windows & Adobe Font)  

Penjelasan secara lebih terperinci format font di atas adalah sebagai berikut:  

1. Bitmap Font  

Merupakan   konsep   awal   font   komputer, dibuat  berdasarkan   titik-titik   yang   

mengisi pola/bentuk tertentu. Kelemahannya apabila diperbesar ukurannya akan 

mengurangi kerapatan susunannya. Aplikasi Bitmap Font pada HP, Kalkulator, printer 

dot matrix. 

2. PostScript Font Type 1 (Adobe Font)  

Adalah font yang memiliki 2 buah format   file; 1 file (Screen = font) untuk tampilan 

layar monitor dan 1 file (Printer Font) untuk percetakan (printer).  Kelemahan PostScript 

Font adalah hanya memuat 256 karakter, lebih dari jumlah itu  harus  membuat file  

baru  (banyak file),  kemudian  terkadang  tampilan  layar  monitor  dengan  hasil  print  

berbeda.  Aplikasi PostScript Font dapat digunakan pada mayoritas komputer. 

3. True Type Font (Apple Font/TTF) 

Merupakan font bawaan Windows, walaupun   awalnya   dibuat   oleh   Macintosh   

(Mac). Keunggulan True Type Font adalah hanya membutuhkan 1 file saja tetapi dapat 

memuat 256 karakter. Sedangkan aplikasinya dapat digunkanan pada semua program 

Windows.  

  



4. Open Type Font 

Open Type Font adalah konsep font yang dikembangkan bersama antara Adobe dan 

Microsoft. Keunggulannya dapat digunakan pada platform computer berbasis Windows 

dan Mac (cross platform). Open Type Font hanya memerlukan 1 file (single file), serta 

memuat fitur-fitur terbaik dari format sebelumnya. Satu file Open Type Font dapat 

memuat 65.536 karakter. Serta menyediakan fitur-fitur tambahan. Untuk aplikasi font 

jenis ini dapat digunakan pada semua Software. 

 

  



MODUL 13 : Praktikum Tipografi  

Materi Estimasi Waktu Capaian Pembelajaran 

a. Langkah – Langkah 

membuat  Tipografi  

b. Langkah – Langkah Input 

Gambar, Teks dan 

Membuat Background 

Materi : 60 Menit  

Praktikum : 110 Menit 

Mahasiswa mampu 

memahami dasar tipografi, 

membuat background dan 

penginputan gambar/teks 

 

MATERI 13 

I. Input Gambar 

1. Input gambar yang akan dipakai dengan klik “File”➜ “Open…” ➜ Pilih Gambar ➜ 

“Open” (Ctrl+O) atau bisa juga dengan pindahkan (drag) dan drop gambar dari 

File Explorer ke canvas projek yang sedang dikerjakan dengan manggunakan move 

tool.  

 

  



2. Lalu atur size-nya dengan memilih menu Edit ➜ Transform ➜ Scale (Ctrl+T) sesuai 

ukuran yang diinginkan. Klik Enter. 

 

 

II. Input Teks 

1. Aktifkan “Type Tool”, pilih “Horizontal Type Tool” lalu klik kiri untuk membuat teks 

area, tulis teks yang diingikan lalu aktifkan toogle character dan paragraph 

palettes yang ada pada tool bar, kemudian atur fontnya mulai dari size, color, 

spasi, font style, paragraph, dsb. 

 



 

 

 

 

III. MEMBUAT BACKRGOUND 

LANGKAH PEMBUATAN 

a. Bukalah file baru (Ctrl+N) dengan ukuran canvas custom dengan rincian Lebar 

menjadi 2000 px dan Tinggi hingga 2000 px. Atur Resolusi menjadi 300 

Pixels/Inci. Beri judul projek dengan nama file “Background”, lalu tekan CREATE. 



 

b. Input gambar background yang akan pakai dengan klik “File”➜ “Open…” ➜ Pilih 

Gambar ➜ “Open” (Ctrl+O) atau bisa juga dengan pindahkan (drag) dan drop 

gambar dari File Explorer ke canvas projek yang sedang dikerjakan dengan 

manggunakan move tool. Lalu atur size-nya dengan memilih menu Edit ➜ Transform 

➜ Scale (Ctrl+T) sesuai ukuran yang diinginkan. Klik Enter. 

 

  



c. Turunkan opacity menjadi 30% agar membuat backrgound terkesan seperti kertas. 

 

 

d. Selanjutnya buat design untuk background dengan manggunakan “Pen Tool”. 

Aktifkan fill, pilih warna dan non aktifkan stroke. Klik dan drag pen tool sampai 

membentuk curva, atur anchor point sampai membentuk sesuai yang diinginkan, 

sambungkan pen tool ke titik awal agar menjadi sebuah shape seperti di bawah ini. 

 



e. Kemudian buat shape ke dua dengan masih menggunakan “Pen Tool” dan dengan cara 

yang sama sampai membentuk shape yang diinginkan dan turunkan Opacitynya 

menjadi 70%. 

 

f. Tambahkan aksen lingkaran dengan menggunakan fitur bernama “Ellipse Tool” (U). 

Klik pada canvas untuk membuka jendela opsi membuat lingkaran. Atur lebar 1208 px 

dan tinggi 1208 px. Klik OK.  

 

  



g. Atur warna, ketebalan stroke, dan non aktifkan fill, sehingga tampilan terlihat 

hanya bagian stroke luar saja. 

 

 

h. Tambahkan aksen lingkaran kecil dengan menggunakan fitur bernama “Ellipse Tool” 

(U). Klik pada canvas untuk membuka jendela opsi membuat lingkaran. 

 

 



Contoh Jadi 

 

Image by Freepik 

 

  



MODUL 14 : Media Visual Poster 

Materi Estimasi Waktu Capaian Pembelajaran 

Media Visual Poster 
Materi : 60 Menit 

Praktikum : 110 Menit 

Mahasiswa mampu 

memahami tentang Poster  

sebagai salah satu media 

visual dan cara 

pembuatannya 

 

Materi 14 

I. Pengertian Poster 

Poster adalah sarana untuk menyampaikan pesan melalui bahasa yang jelas, singkat dan 

mudah dipahami dan dilengkapi oleh gambar, foto, dekorasi grafis sebagai ilustrasi dan 

pelengkap penjelasan pesan. 

Poster sering digunakan untuk mempromosikan berbagai kegiatan atau pertunjukan 

seperti pementasan film, tari, musik, teater dsb. Poster juga banyak digunakan untuk 

mengkampanyekan berbagai pesan sosial seperti issue lingkungan, kesehatan dan 

sejenisnya. 

Poster dari sisi desain grafis lebih tepat dipahami sebagai salah satu seni grafis yang 

memiliki gaya, aliran, maupun trend tersendiri dari suatu zaman. Karena poster dibuat 

untuk menyampaikan pesan atau informasi, maka poster menjadi elemen dalam Desain 

Komunikasi Visual. 

 

II. Pengertian Poster Menurut Para Ahli 

Poster adalah media komunikasi efektif untuk menyampaikan pesan singkat, padat dan 

impresif, karena ukutannya yang relatif besar. (Kustandi dan Sutjipto, 2011: 50). 

Hasnun (2006: 253) menyatakan bahwa poster adalah gambar atau tulisan diatas kertas 

atau kain yang dipasang ditempat umum dan berisi pemberitahuan yang beragam 

berdasarkan tujuan dan kebutuhannya. 

Sudjana dan Rivai (2005: 51) Poster adalah kombinasi visual dari rancangan yang kuat 

dengan warna dan pesan yang bermaksud untuk menangkap perhatian orang banyak dan 

dapat menanamkan gagasan didalam ingatan mereka. 

 

  



III. Fungsi Poster 

Fungsi poster adalah untuk menyampaikan pesan secara jelas, singkat dan menarik 

menggunakan bahasa/kata dan gambar. Itu adalah fungsi utamanya, namun, selain itu 

menurut Sudjana dan Rivai (2005: 56) poster memiliki beberapa fungsi antara lain: 

1. Sebagai Motivasi. Poster dapat dibuat untuk mendorong motivasi seseorang, misalnya 

untuk meningkatkan motivasi kegiatan belajar siswa. Poster tidak memuat informasi 

secara langsung, namun hanya berisi ajakan, renungan, persuasi atau kisah sukses. 

2. Sebagai peringatan. Berisi peringatan-peringatan seperti pengingat untuk mematuhi 

peraturan hukum, peraturan sekolah, hingga untuk menjaga ketertiban sosial. 

3. Pengalaman kreatif. Melalui poster kita dapat menginformasikan berbagai 

pementasan kreatif yang tidak hanya menyajikan hiburan saja, tetapi juga mengasah 

kreativitas, baik bagi para pelaku seninya, maupun yang mengadakan pementasan, 

pameran, bazaar, dsb. 

 

IV. Manfaat Poster 

Beberapa manfaat poster menurut Hernawan, dkk. (2007: 13) sebagai berikut: 

1. Penggerak perhatian. Misalnya poster disimpan didekat tempat sampah dan berisi 

pesan “jagalah kebersihan” sebagai konteks perhatian lebih agar masyarakat membuang 

sampah pada tempatnya. 

2. Sebagai petunjuk. Poster dapat menunjukan dimana suatu tempat pariwisata berada 

dan apa saja yang ada disana dan ditempatkan dijalan perbatasan kota sebagai bahan 

konsiderasi orang luar daerah untuk berwisata kesana. 

3. Sebagai peringatan. Misalnya poster ditempatkan didaerah yang memang memiliki 

angka kecelakaan tinggi, dsb. 

4. Pengalaman kreatif. Untuk menunjukan pertunjukan seni. 

5. Tidak hanya aplikasi politik, tetapi juga untuk mengkampanyekan berbagai isu 

lingkungan atau sosial lainnya. 

 

V. Jenis-jenis Poster 

Poster dapat dibedakan berdasarkan isi dan tujuannya, yaitu: 

1. Jenis Poster berdasarkan Isi: 

a. Poster Kegiatan. Merupakan poster dengan informasi suatu kegiatan (event) yang 

akan dilaksanakan, seperti: pameran, pentas seni, kegiatan sosial dan isu lingkungan, 

dsb. 



b. Poster Niaga (Bisnis/Dagang). Yaitu poster yang berisi tawaran untuk 

menggunakan produk/jasa seperti: poster produk minuman, makanan, poster jasa 

desain, dsb. 

c. Poster Layanan Masyarakat. Poster yang berisi edukasi atau ajakan kepada 

masyarakat umum terhadap suatu isu yang bersangkutan dengan masyarakat, 

seperti: keluarga berencana, bahaya merokok, dsb. 

d. Poster Pendidikan. Poster yang berhubungan langsung dengan pendidikan, 

biasanya dibuat di sekolah atau lingkungan kampus perguruan tinggi. 

 

2. Jenis Poster berdasarkan Tujuan: 

a. Poster Komersial, poster untuk mempromosikan barang dan jasa. 

b. Poster Kampanye, untuk mengambil simpati masyarakat terhadap suatu isu, tokoh, 

atau lembaga politik. 

c. Poster Propaganda, poster yang berusaha menggiring opini publik. 

d. Poster Film, untuk mempromosikan sebuah karya film. 

e. Poster Komik, mempromosikan sebuah komik. 

f. Poster Afirmasi, untuk memotivasi pembacanya. 

g. Poster Wanted (Pencarian), untuk mencari orang hilang. 

h. Poster “Cheesecake”, untuk mencari perhatian publik, Umumnya poster ini berisi 

gambar-gambar orang terkenal seperti penyanyi, artis, dan lain sebagainya yang bisa 

menarik perhatian orang banyak.  

i. Poster Riset, untuk mempromosikan atau merekrut kebutuhan suatu 

riset/penelitian. 

j. Poster Kelas, digunakan untuk memberikan motivasi, pendidikan atau inspirasi bagi 

lingkungan pendidikan (sekolah). 

 

VI. Tips Membuat Poster 

Melihat fungsinya yang beragam namun berfokus pada penyampaian pesan yang efektif, 

maka membuat poster memerlukan perancangan yang matang. Berikut ini adalah beberapa 

cara yang tepat dalam membuat sebuah poster, antara lain: 

1. Menentukan Topik & Tujuan 

Topik yang berkesinambungan dengan tujuan adalah langkah pertama yang harus 

dilakukan. Kita harus menentukan tema berdasarkan pesan yang ingin disampaikan agar 

poster efektif. Berdasarkan tema dan tujuan yang telah disiapkan tersebut kita mulai 



dapat memikirkan bentuk visual dan kata yang digunakan untuk membuat poster 

tersebut. 

2. Membuat Kalimat Singkat dan Mudah Diingat 

Fungsi poster adalah mengirim pesan kepada orang yang melihatnya, 

sehingga setiap kata yang ada haruslah mudah dipahami dan berkesan. Dengan 

melihat kalimat yang berkesan, orang akan mengingatnya dengan mudah dan 

dapat menempel terus dipikirannya. 

3. Menggunakan Gambar 

Gambar adalah salah satu penyampai pesan yang paling menarik. Sehingga 

poster haruslah menggunakan gambar untuk mencapai salah satu tujuannya, 

yaitu menyampaikan pesan dengan jelas dan menarik. Sehingga poster akan 

mengundang perhatian dan menarik minat baca yang melihatnya. 

Rasio atau proporsi gambar dan kata harus disesuaikan dengan tema dan 

tujuan yang dimaksud. Poster juga dapat memuat gambar bercerita 

atau komik didalamnya. Namun esensi poster harus tetap ada, yaitu 

menyampaikan suatu pesan dengan jelas, singkat dan menarik. 

4. Menggunakan Media yang Tepat 

Tentukan media pembuatan poster seperti kertas, kain, dan bahan lainnya 

yang mendukung. Memilih media pembuatan poster pastinya akan selalu 

berhubungan dengan tempat penempelan poster tersebut. 

 

 

 

 

 

 

 

 

 

 

https://serupa.id/menggambar-komik-pengertian-dan-langkah/


MODUL 15 : Cara Membuat Media Visual Poster 

Materi 
Estimasi 

Waktu 
Capaian Pembelajaran 

Cara Membuat 

Poster  

Materi : 60 

Menit 

Praktikum : 

110 Menit 

Mahasiswa diharapkan mampu : 
1. Membuat poster dengan menggunakan berbagai macam 

tool yang ada di Adobe Photoshop 
2. Membuat file photoshop baru 
3. Membuat background 
4. Membuat guide baru 
5. Insert dan edit gambar 
6. Insert dan edit tulisan 
7. Membuat efek/kreasi pada gambar/tulisan 
8. Menyimpan file poster untuk web 
9. Insert dan edit tulisan 
10. Membuat efek/kreasi pada gambar/tulisan 
11. Menyimpan file poster untuk web 

 

MATERI 15  

 

I. Langkah Pembuatan Poster di Adobe Photoshop  

1. Membuat File Photoshop Baru 

a. Bukalah file baru (Ctrl+N) dengan ukuran canvas A4 dengan rincian Lebar menjadi 

2480 px dan Tinggi hingga 3508 px. Atur Resolusi menjadi 300 Pixels/Inci. 

Beri judul projek dengan nama file “Poster Kesehatan”, lalu tekan CREATE. 

 

 

 



2. Membuat Background 

a. Jika lembar project baru sudah terbuka, langsung saja kita mulai dengan mengubah 

warna background dengan tool bernama “Solid Color“.  

 

b. Solid Color ➜ pilih warna #5c298b. 

 

 

3. Membuat Guide Baru 

a. Silahkan buat guide di bagian tepi untuk mengatur posisi shape dan text yang persisi 

nantinya. Caranya tinggal buka menu “View” ➜ “New Guide Layout”. 



 

b. Buat Columns = 1 dan Rows = 1, Margin Top, Left, Bottom dan Right 0,5 in. 

Klik OK. 

 

 



4. Insert Dan Edit Gambar 

a. Import gambar yang akan di input dengan klik “File”➜ “Open…” ➜ Pilih Gambar 

➜ “Open” (Ctrl+O) atau bisa juga dengan pindahkan (drag) dan drop gambar 

dari File Explorer ke canvas projek yang sedang dikerjakan dengan manggunakan 

move tool.  

 

 

b. Lalu atur size-nya dengan memilih menu Edit ➜ Transform ➜ Scale (Ctrl+T), 

hingga seperti gambar dibawah ini. 

 

 



c. Ubah blending mode dan pilih “Luminosity” untuk mencampur luminosity warna 

pada layer yang aktif dengan nilai saturasi dan hue dari layer di bawahnya. 

 

 

d. Ubah Opacity menjadi 25%. 

 

 

 

 

 

 



5. Insert Dan Edit Tulisan 

a. Untuk tulisan judul, aktifkan Type Tool, pilih Horizontal Type Tool lalu klik kiri 

untuk membuat teks area, tulis teks yang diingikan lalu aktifkan toogle character 

dan paragraph palettes yang ada pada tool bar, kemudian kita atur fontnya: 

 

 

b. Kemudian kita buat sub title, body text dengan cara yang sama seperti langkah 

sebelumnya. 

 

 



 

 

c. Untuk edit tulisan agar jaraknya sama rata dan rata tengah kita klik layer yang 

akan diratakan lalu kita gunakan “Distribute Vertical Centers” dan “Align 

Horizontal Center” yang berada di Option Bar pada Move Tool. 

 

 

 

d. Untuk edit tulisan agar jaraknya sama rata dan rata kiri kita klik layer yang akan 

diratakan lalu kita gunakan “Distribute Vertical Centers” dan “Align Left Edges” 

yang berada di Option Bar pada Move Tool. 



 

 

e. Untuk edit tulisan ”COVID19” menjadi transparan kita turunkan opacity-nya 

menjadi 6%. 

 

 

 

 

 

 

 



 

f. Selanjutnya input logo beserta tulisannya sesuai kebutuhan Anda.  

  

 

6. Membuat Efek/Kreasi Pada Gambar/Tulisan 

a. Membuat Shape 

1) Disini kita akan berikan beberapa aksen lingkaran dengan menggunakan fitur 

bernama “Ellipse Tool” (U). Klik pada canvas untuk membuka jendela opsi 

membuat lingkaran. Atur lebar 144 px dan tinggi 144 px. Klik OK.  

2) Atur warna, ketebalan stroke, dan non aktifkan fill, sehingga tampilan 

terlihat hanya bagian stroke luar saja dan pilih stroke option berupa garis putus-

putus. 

 

 



 

 

 

3) Duplikat lingkaran sebanyak tiga kali dengan klik kanan pada layer > 

Duplicate Layers ataupun juga bisa dengan Ctrl+J. Kemudian atur posisi rata 

tengah dan sejajar. 

 

 

4) Selanjutnya buat beberapa aksen garis dengan menggunakan fitur bernama “Line 

Tool” (U). Klik dan drag pada canvas bersamaan dengan tekan shift sampai 

membentuk garis lurus.  



5) Atur warna, ketebalan stroke, dan pilih stroke option berupa garis putus-

putus. 

 

 

6) Duplikat garis sebanyak dua kali dengan klik kanan pada layer > Duplicate 

Layers ataupun juga bisa dengan Ctrl+J. Kemudian atur posisi rata tengah dan 

sejajar. 

 

 

7) Selanjutnya kita akan menambahkan aksen persegi panjang dengan 

menggunakan fitur bernama “Rectangle Tool” (U). Klik pada canvas untuk 



membuka jendela opsi membuat retangle. Atur lebar 83 px dan tinggi 3508 px. 

Klik OK. Aktifkan fill dan pilih warna, non aktifkan stroke dan atur posisi. 

 

 

8) Selanjutnya kita kan menambahkan aksen sosial media berupa gambar yang dapat 

diinput dengan cara klik “File”➜ “Open…” ➜ Pilih Gambar ➜ “Open” 

(Ctrl+O) atau dengan cara klik dan drag dari File Explorer. Kemudian posisikan 

gambar dengan rapi. 

 

 

  



b. Membuat Efek Color Overlay 

1) Input gambar yang akan diimport dengan klik “File” ➜ “Open…” ➜ Pilih 

Gambar ➜ “Open” (Ctrl+O) atau dengan cara klik dan drag dari File Explorer. 

Kemudian posisikan gambar dengan rapi. 

 

 

2) Selanjutnya ganti warna gambar dengan menggunakan layer style color overlay 

agar warnanya sesuai dengan color palate yang dipakai. Pada layer yang akan 

diberi efek, pilih menu Layer ➜ Add Layer Style ➜ Color Overlay. Setelah 

terbuka menu Layer Style pilih warna dan Blending Mode Normal. 

  



 

 

3) Untuk mempercepat pekerjaan, layer style dapat diduplikat dengan cara Klik 

Kanan pada Layer Effect ➜ Copy Layer Style ➜ Klik Kanan pada Layer 

yang akan di Paste ➜ Paste Layer Style. 

 



 

 

c. Membuat Efek Stroke 

1) Import gambar yang akan diimport dengan klik “File” ➜ “Open…” ➜ Pilih 

Gambar ➜ “Open” (Ctrl+O) atau bisa juga dengan pindahkan (drag) dan 

drop gambar dari File Explorer ke canvas projek yang sedang dikerjakan dengan 

manggunakan move tool. Kemudian posisikan gambar agar terlihat apik. 

 

 

2) Untuk menambahkan efek stroke pada layer gambar dengan cara Add Layer 

Style ➜ Stroke. Setelah terbuka menu Layer Style atur Size, Position, Blend 

Mode, Opacity, dan Color. Lalu klik OK. 



 

 

 

d. Membuat Efek Drop Shadow 

1) Untuk menambahkan efek drop shadow pada layer gambar dengan cara Add 

Layer Style ➜ Drop Shadow. Setelah terbuka menu Layer Style atur Blend 

Mode, Color, Opacity, Angle, Distance, Spread, Size, dan Quality. Lalu klik 

OK. 



 

 

 

e. Membuat Efek Glow Menggunakan Brush Tool 

1) Untuk menambahkan gradasi dan efek glow pada background dapat 

menggunakan brush tool dengan Create New Layer (letakkan layer di bawah 

layer gambar) ➜ Brush Tool (B) ➜ Klik Kanan pada canvas ➜ Pilih brush Hard 

Round dengan Size 2000 px dan Hardness 100% ➜ Pilih Warna ➜ Klik 

Kiri pada canvas untuk membuat brush. 



 

 

 

2) Klik Filter ➜ Blur ➜ Gaussian Blur ➜ Muncul Jendela Opsi Gaussian Blur > 

Atur Radius menjadi 700 px ➜ Klik OK ➜ Turunkan Opacity menjadi 75%. 



 

 

 

 

 



7. Menyimpan File Untuk Web 

a. Setelah semuanya dirasa sudah pas dan fix, tekan tombol “CTRL + S” untuk 

menyimpan project posternya. Jangan lupa simpan project asli jika suatu saat akan 

dibutuhkan atau diedit kembali. 

b. Sedangkan untuk format posternya bisa pilih PNG/JPEG dengan klik File ➜ Export 

➜ Save for Web (Legacy) atau (Alt+Shift+Ctrl+S).  

c. Pilih jenis file/preset yang Anda ingin simpan dokumennya. Di bawah ukuran gambar, 

Anda dapat mengubah ukuran pixel gambar jika Anda mempunyai kendala ukuran. 

d. Di sebelah kiri bawah, Anda dapat melihat preview dari ukuran file. Hal ini berguna 

bila ada kendala ukuran pada sebuah situs web dan Anda perlu menurunkan kualitas 

atau ukuran gambar. 

e. Klik Save dan poster sudah jadi dan siap untuk diupload di web/dicetak. 

 

 



LEMBAR KERJA 

 

Tujuan Tugas :  Mahasiswa mampu membuat poster dengan panduan yang telah 

dipelajari pada materi-materi perkuliahan dengan menggunakan 

software Adobe Photoshop. 

 

Metode/Cara Pengerjaan Tugas : 

1. Desain yang dibuat menggunakan tools dan efek-efek yang dipelajari pada adobe 

photoshop. 

2. Material untuk pembuatan poster dapat diperoleh link berikut 

https://drive.google.com/drive/folders/1bCPGDacmdZtSF3fpoRRRFyJZn6CNUDHe?us

p=sharing. 

3. Ukuran Poster berupa A4 dengan rincian Width = 2480 px, Height = 3508 px, 

Resolution = 300 px/inch. 

4. Softfile karya mahasiswa disave dan dikumpulkan dalam format desain PNG, beserta 

identitas mahasiswa yang jelas dalam format “Nama_NIM_Tugas Redesign Poster”. 

 

Contoh Tugas Redesign : 

 

Sumber: Freepik 

 

  

https://drive.google.com/drive/folders/1bCPGDacmdZtSF3fpoRRRFyJZn6CNUDHe?usp=sharing
https://drive.google.com/drive/folders/1bCPGDacmdZtSF3fpoRRRFyJZn6CNUDHe?usp=sharing


MODUL 16 :  Pretesting Media 

Materi Estimasi Waktu Capaian Pembelajaran 

a. Tentang Pretesting 

(Pengertian, Tujuan, 

Alasan) 

b. Tahapan Pretesting 

Media  

c. Metode – Metode 

Pretesting Media  

Materi : 60 Menit 

Praktikum : 110 Menit 

Mahasiswa mampu 

memahami tentang Poster  

sebagai salah satu media 

visual dan cara 

pembuatannya 

 

Materi 16 

I. Tentang Pretesting  

Prestesting atau pretest merupakan proses sistematis mengumpulkan reaksi target 

audiens atas pesan dan materi sebelum diprosuksi dalam bentuk final. Pretest dapat 

membantu menentukan beberapa alternatif eksekusi mefia mana yang paling efektif atau 

digunakan utuk mengidentifikasi kekuatan dan kelemahannya.  

Pretesting Media bertujuan untuk memahami pesan yang ditangkap oleh sasaran dari 

media yang sudah dibuat, memahami tingkat pemahaman sasaran terdahap kegiatan atau 

campaign yang sedang dilakukan, memahami apakah sasaran dapat menangkap konsep 

yang diberikan dan memahami mengapa sasaran menolak intervensi dari program yang 

diberikan.  

Pretesting media dibuat untuk menjawab pertanyaan seperti: 

1. Perhatian : Apakah pesan menarik dan/atau mengundang perhatian audiens? 

2. Pemahaman : Apakah pesan dipahami secara jelas? Apakah ide utama mudah 

dimengerti? 

3. Relevansi Personal: Apakah target audiens merasa pesan yang disampaikan relevan bagi 

dirinya? 

4. Kepercayaa : Apakah pesan dan.atau sumbernya dianggap dapat dipercaya? 

5. Penerimaan : Apakah ada pesan yang dianggap menyerang atau tidak dapat 

diterima? 

 

  



II. Tahapan Pretesting 

1. Pengembangan Konsep 

Pesan diuji untuk mengeksplorasi prioritas keginginan dan kebutuhan komunikan. 

Contohnya : Konsep dalam perubahan perilaku kesehatan dimana ide yang dapat 

dilakukan yaitu dengan memvariasikan cara berkomunikasi dengan para komunikan. 

2. Membuat Rancangan Produk  

Sebuah rancangan materi, pesan, dan / atau kegiatan dikembangkan dan disiapkan 

untuk pretest. 

Contohnya : Pesan tersebuut berisikan ajakan dalam perubahan perilaku.  

3. Mempersiapkan Bahan Alternatif Dari Produk 

Untuk mempertimbangkan pengujian versi alternatif dari bahan. 

Contohnya : Sarana prasarana yang mudah untuk ditemukan dalam mengkomunikasikan 

pesan tersebut. 

4. Pengujian Produk Akhir 

Pengujian produk akhir kepada komunikan atau audiens. 

Contohnya : Hasil akhir dari produk yang dibuat. 

 

III. Metode – Metode Pretesting Media 

1. Readbility Testing  

Metode ini bertujuan untuk menentukan gradiasi tingkat keterbacaan dari draft media 

KIE yang ada. Untuk melakukan tes ini haya dibutuhkan waktu 15 menit.  

Keuntungan dari tes ini adalah murah dan tidak membutuhkan responden, sedangkan 

kelemahannya adalah tidak menyediakan reaksi dari target audiens atas draf yang ada 

karena biasanaya dilakukan sendiri oleh pembuatan media KIE atau staf program 

lainnya. 

 Jenis media KIE yang cocok dites dengan metode ini adalah semua media KIE yang 

melibatakan tulisan dalam jumlah relative banyak khususnya leaflet, booklet, artikel atau 

draf manuskrip lainnya.  

2. Focus Group Interviews 

Metode ini bertujuan untuk mendapatkan insight berdasarkan persepsi, keyakinan dan 

Bahasa target audiens. Khususnya ditahap awal pengembangan media KIE.  

Materi yang cocok dites dengan metode jenis ini adalah iklan TV, radio, konsep pesan 

yang akan dicetak, tema, logo dan artwork kasar.  

Jumlah ideal responden yang dibutuhkan adalah 8-12 orang dan minimal dilakukan 

pada 4 kelompok diskusi. Waktu yang dibutuhkan sekitar 3-4 minggu dengan 2 minggu 



rekrutmen responden dan pengaturan kelompok, 90 menit interview/kelompok, 2 hari 

untuk semua kelompok. 5 hari analisis hasill interview dan penulisan laporan. Hal – hal 

yang dibutuhkan antara lain outline diskusi, moderator yang terlatih, responden sesuai 

target audiens, ruang diskusi yang nyaman, dan audio/video recorder.  

Keuntungan menggunakan tes jenis ini adalah atmosfer kelompok menjasi stimulasi 

yang bagus bagi semua responden untuk berbicara daripada interview individual dan 

juga teknik ini baik untuk mendapatkan informasi kualitatif dari beberapa responden 

dalam waktu singkat dan tahap pengembangan pesan dapat dilakukan lebih cepat, 

kelemahannya adalah tidak bisa digunakan untuk mengumpulkan data kuantitatif. 

3. Individual In-dept interviews  

Metode ini bertujuan untuk mendapatkan indormasi yang mendalam tentang sikap, 

keyakinan dan emosi audiens.  

Materi yang cocok dites dalam metode ini adalah konsep pesan terutama yang 

dianggap sensistif atau kontroversial. Waktu yang dibutuhkan sekutar 4-6 minggu.  

Hal-hal yang dibutuhkan antara lain panduan wawancara, pewawancara yang terlatih, 

ruang yang nyaman dan tape recorder.  

Keuntungan metode ini adalah memungkinkan penggalian informasi yang mendalam 

terutama isu yang dianggap sensistif dan bagus untuk targer audiens yang sulit 

dijangkau. Kelemahannya adalah memakan banyak waktu baik untuk mengatur, 

melakukan dan menganalisis hasil dan tidak dapat dugunakan untuk generalisasi.  

4. Central Location Intercept Interviews 

Metode ini dilakukan dengan cara “mencegat” responden di tempat yang paling sering 

didatangi oleh target audiens, audiens ditawarkan untuk melakukan pre test media KIE. 

Jika bersedia, beberapa pertanyaan screening diajukan untuk memastikan apakah 

respoden sesuai dengan kriteria yang diinginkan atau tidak. Jika ya, maka responden 

dibawa ke ke tempat di sekitar area tersebut yang telah disiapkan untuk diwawancarai 

dan diperlihatkan rancangan media KIE yang ada  

Tujuan metode ini adalah untuk mendapatkan reaksi audiens atas konsep dan pesan 

dari sebanyak mungkin orang dalam waktu singkat. Jumlah responden ideal adalah 100-

200 orang. Waktu yang diperlukan adalah 4-6 minggu. Hal-hal yang diperlukan antara 

lain: kuisioner terstruktur, pewawancara terlatih, akses ke tempat yang paling sering 

didatangi responden dari target audiens yang diinginkan, ruangan wawancara.  

Keuntungan metode ini adalah cepeat dengan jumlah responden yang banyak, 

fleksibel untuk pretest beragam material, bisa dilakukan di hamper semua tempat, 

pertanyaannya tertutup mempercepat analisis hasil. Kelemahannya adalah tidak cocok 



untuk memprobing topik media KIE yang sensitive atau emosional dan interview tidak 

dapat dilakukan lama atau responden akan segera pergi.  

5. Self-Administered Questionnarie 

Metode ini hamper sama dengan metode individual in-dept interview hanya saja 

caranya tidak diwawancarai tetapi responden mengisi sendiri kuisioner yang telah 

disediakan. 

6. Gatekeeper Review 

Gatekeeper yang dimaksud di sini adalah individu atau organisasi yang biasanya 

berinteraksi langsung dengan target audiens. Contohnya adalah LSM, organisasi profesi 

, professional kesehatan atau kelompok-kelompok swadaya masyarakat. Caranya adalah 

dengan meminta umpan balik melalui diskusi terbatas dengan 10-25 orang diantara 

mereka. 

  



LEMBAR KERJA 

Nama   : 

NIM  : 

Jenis Tugas : Praktek Kelompok  

Metode/Cara Pengerjaan Tugas: 

1. Melakukan pretesting media kesehatan visual maupun audiovisual dengan tema yang 

sudah ditentukan  

2. Hasil pretesting dimasukkan kedalam laporan tugas akhir   
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